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1.  Introduction

1.1 Background

The Future ATM Concepts Evaluation Tool (FACET) is a flexible  environment
for exploration, development, and evaluation of advanced Air Traffic
Management (ATM) concepts for the National Airspace System (NAS).
Development of this system was initiated under NASA’s Advanced Air
Transportation Technologies (AATT) Project and continues under the current
Strategic Airspace Usage (SAU) Project. Examples of ATM concepts studied for
AATT using FACET are: aircraft self-separation for Free Flight, modeling and
prediction of air traffic controller workload and airspace complexity, decision
support tool for direct routing, integration of space launch vehicle operations
into the NAS air traffic, and advanced Traffic Flow Management techniques.

As part of the SAU Project, FACET derivatives called the System Wide
Evaluation and Planning Tool (SWEPT) and FACET-Airline Operation Center
(FACET-AOC) are currently being developed.  Augmentation and modifications
to FACET to support the Federal Aviation Administration are referred to as
SWEPT, while those FACET modifications supporting AOC applications are
referred to as FACET-AOC.  A graphical representation of the relationship
between FACET, FACET-AOC, and SWEPT is shown in Fig. 1.1.  As can be seen
from this notional figure, all three systems utilize common trajectory prediction
and route parsing algorithms using airspace adaptations, aircraft performance
models, and weather data. The core of FACET also stores and queries MySQL
flight and sector databases.
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Figure 1-1: FACET /SWEPT/FACET-AOC Connection

1.2 Purpose

The purpose of this document is to provide a new FACET user with a high level
overview of the system’s many applications, settings, and uses.  For each
application or setting panel an attempt has been made to give a general
description of what the application or panel is used for and how to set up the
application or panel.  Since both SWEPT and FACET-AOC are envisioned to
utilize many of FACET’s core capabilities, this manual may also appeal to users
of these systems.

1.3 Document Organization

A general description of the various application and setup panels in FACET are
provided in Section 2 of this document.  This section is organized around the
layout of the FACET menus, so the Animation menu items are discussed first,
followed by the Simulation, Airspace, Aircraft, and Applications menu items.

Section 3 of this document describes how to invoke and utilize a small subset of
FACET’s capabilities.  The list of items discussed in this section is nowhere near
exhaustive.  For additional information about any particular application, the
interested reader is encouraged to contact a member of the FACET development
team. However, online ‘Help’ menu items are available under most
applications.
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2.  System Orientation

This section contains descriptions and sample inputs for the major applications
available in FACET.  These applications are organized in accordance with the
five main menu items appearing on the FACET display.  The five main menu
items are:

1. Animation

2. Simulation

3. Airspace

4. Aircraft

5. Applications

2.1 Animation

The Animation menu that is shown in Fig. 2-1 contains controls for pausing,
resuming, restarting, terminating, and exiting a FACET run.  Because the pause,
resume, and terminate controls are used so frequently, they are also accessible
via the FACET toolbar, located just under the main Menu items, depicted in
Figure 2-2.  In this figure, the stop sign image is the terminate control, while the
right arrow image is the resume control.  The pause control image shares the
same location as the right arrow image and is only viewable when a FACET run
is in place.  A description of each of menu items appearing in the Animation
menu follows.

Figure 2-1: FACET Animation Menu
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Figure 2-2: FACET Toolbar

2.1.1 Pause/Resume

The Pause/Resume menu item is used to temporarily pause a FACET run or
resume a previously paused run.  Alternatively, the Pause/Resume icon on the
FACET toolbar can also be used to pause/resume a FACET run.

2.1.2 Restart

The Restart menu item is used to restart a previously terminated FACET run.
This menu item should only be used in the playback, simulation, and hybrid
modes of operation.

2.1.2 Terminate

The Terminate menu item is used to stop an existing FACET run.  Alternatively,
the Terminate icon that is shown as a red stop sign can also be used to terminate
a FACET run.

2.1.3 About

Selecting the About menu displays a dialog box that acknowledges the
contributions of the original FACET developers and the software version
number.

2.1.4 Exit

The Exit menu item terminates the current FACET session.

2.2 Simulation

The Simulation menu that is shown in Fig. 2-3 is used to start a new FACET run,
save user preferences, change the aircraft navigation law, add new aircraft to an
existing simulation, and record aircraft data for future processing.  Of these
submenu items, the New Run and Preferences menu items are the most often
used during normal FACET operations.  A description of each of these menu
items follows.
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Figure 2-3: FACET Simulation Menu

2.2.1 New Run

By selecting the New Run menu item, the dialog appearing in Fig. 2-4 is
displayed to the user.  From this dialog box, a user can start a new FACET run or
change the settings of an existing FACET run.  As can be seen from Fig. 2-4,
FACET is capable of operating in one of the following modes: Simulation,
Playback, Hybrid, and Live.  A description of each of these modes follows.

2.2.1.1 Simulation Mode

Various parameters that are available for initiating a simulation in FACET are
displayed in Fig. 2-4.  In this mode, FACET generates a four-dimensional
trajectory for each aircraft either along a flight plan route or along a direct (i.e.
great circle) route.  By default, track updates (i.e. TZ messages in an ASDI data
feed) are ignored during simulation mode, but selecting the “Allow Track
Updates” check box can include these.

Simulations in FACET can be conducted either asynchronously or
synchronously.  A user can toggle between these two modes via the radio
buttons on the dialog box in Fig. 2-4.  In asynchronous mode, which is the default
simulation mode, the rate at which all aircraft trajectories are updated and
displayed is limited, in practice, only by the processing capabilities of the
computer being used.  Synchronous mode on the other hand is useful if a user
wishes to maintain a fixed correlation between the rate at which aircraft are
updated on the display and clock time.  A typical asynchronous mode simulation
of traffic over a 24-hour period will take on the order 30 minutes to complete,
whereas a synchronous mode simulation can be made to take 24 or more hours
to complete.

For an asynchronous simulation, a user can also specify the trajectory update
interval, integration step size and additional update delay.  The default values of
these three parameters are 60 seconds, 60 seconds, and 0.3 seconds., respectively.
In the asynchronous mode, the number of successive integration steps required
by FACET is computed as n = (T/I), where T is the trajectory update interval that
governs the traffic display time interval and I is the integration time step. If n is
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not an integer, the smallest integer greater than n, N, is used. FACET then
recomputes the integration step size to be I = (T/N). If the ratio of the trajectory
update time interval T to the integration time step I is less than one but greater
than or equal to 0.5, an error message will be displayed.  Finally, the “additional
update delay” parameter can be used to enhance the controllability of the FACET
display in the event that the supporting hardware is not properly synchronizing
user input requests (e.g. mouse clicks) and screen updates.  Under most
circumstances, this parameter will not require modifications.

In a synchronous simulation mode, the traffic display is updated at a user
specified rate. This choice is useful for making the display update like a Traffic
Situation Display for example.  In this mode, FACET performs all its calculations
and then waits until the end of the display interval is reached before updating
the display.  If F is a user defined time scale factor, D is the display update
interval, and I is the integration step size, then the number of successive
integration time steps that FACET computes before displaying the results is
given by n = (F*D)/I. If n is not an integer, FACET recomputes the integration
step size as I = (F*D)/N where N is the smallest integer greater than n. It takes n
steps and waits until D seconds have elapsed prior to displaying the results.

Additional information regarding the synchronous and asynchronous modes of
operation can be found in Appendix A.

Finally, the user specifies the file from which a simulation should be initiated by
either entering the file name with directory path into the “File” field in Fig. 2-4,
or by selecting the “Browse” button and manually selecting the startup file.
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\

Figure 2-4: Simulation Setup Panel

2.2.1.2 Playback Mode

Various parameters that are available for initiating a playback run in FACET are
shown in Fig. 2-5.  The left most image in this figure shows the asynchronous
setup parameters, while the right most image shows the synchronous setup
parameters.  In playback mode, FACET redisplays the position (e.g. TZ
messages) for each aircraft in the system.  Position information is typically
obtained from an archived ETMS or ASDI data file that is specified in the “File”
field or manually selected via the “Browse” button on the playback dialog box.
During playback, FACET coasts flights if data drops are encountered and filters
extraneous altitude data if the “Filter Altitudes” checkbox has been selected on
the playback setup dialog.  As in the simulation mode, the playback mode can
operate in either a synchronous or asynchronous fashion.  For a general
description of these two modes, the reader is referred to subsection 2.2.1.1.
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Figure 2-5: Playback Setup Panel

In the asynchronous mode (see the left-most image in Fig. 2-5), FACET reads the
prerecorded data for the time at the end of the “Trajectory Update Interval” (T)
and displays it without introducing any delays. The display rate is a function of
the amount of time needed for reading the prerecorded data. If the time specified
in the prerecorded file does not match the time at the end of the update step,
FACET displays the data for the last time instant in the file, which is just before
the desired time instant.  By contrast, in the synchronous mode (see the right-
most image in Fig. 2-5), FACET reads the recorded data for the time at the end of
update step (F*D) and then waits until the end of the display update interval (D)
is reached before updating the display.  Here F is the “Time Scale Factor”.  The
display interval is tied to the real system clock. If the time specified in the
recorded file does not match the time at the end of the update step, FACET
displays the traffic data at the previous time (nearest to the desired time)
specified in the recorded file. Additional information regarding the synchronous
and asynchronous modes of operation can be found in Appendix A.

The “Additional Update Delay” field in Fig. 2-5 is used to speed up and slow
down an asynchronous simulation.  This setting is especially useful when
running simulations with very small numbers of aircraft.  Under these situations,
aircraft may move across the FACET display more rapidly then desired.
Increasing the additional update delay under these situations will allow for
better viewability of the simulated aircraft.

Finally, the input file that is used to initialize the FACET playback is specified by
either entering the file name into the “File” field in Fig. 2-5, or by selecting the
“Browse” button and manually selecting the startup file.

2.2.1.3 Hybrid Mode
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The hybrid mode is a combination of FACET’s simulation and playback modes.
By default, the position of aircraft in this mode will be displayed in accordance
with the position information (i.e. TZ messages) appearing in the input file.  A
subset of the aircraft can however be modified to travel on alternative paths
using one of FACET’s “NAS Constraint” models (see Section 2.5.10).  The aircraft
trajectories for flights implemented by one of these constraints will be generated
using FACET’s trajectory modeling algorithms.

The panel that is used to invoke the hybrid mode is shown in Fig. 2-6.  Selecting
the “Filter Altitudes” checkbox filters extraneous altitude entries appearing in
the input file.  The hybrid mode currently only operates in asynchronous mode
and the “Trajectory Update Interval” and “Additional Update Delay” are
settable from the panel shown in Fig. 2-6.  Recall from previous discussions that
the Trajectory Update Interval is used by FACET to determine how much of the
prerecorded data to read prior to redisplaying the aircraft positions on the
FACET display. The “Additional Update Delay” field in Fig. 2-5 is used enhance
the controllability of the FACET display in the event that the supporting
hardware is not properly synchronizing user input requests (e.g. mouse clicks)
and screen updates.  Under most circumstances, this parameter will not require
modification.

Constraints that can be used to alter the trajectories of select aircraft will be
discussed in more detail in subsection 2.5.10.  To invoke any of these constraints,
the “Implement Constraints” button can be selected.  Upon canceling any
implemented constraints, the user can choose to have the impacted aircraft either
continue flying in accordance with the constraint or fly in accordance with the
track messages appearing in the input file.

Finally, the input file that is used to initialize the hybrid run is specified by either
entering the file name into the “File” field in Fig. 2-6, or by selecting the
“Browse” button and manually selecting the startup file.
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Figure 2-6: Hybrid Setup Panel

2.2.1.4 Live Mode

In live mode, FACET can be used to connect to either a real-time ASDI or ETMS
data feed.  When connecting to a real-time ASDI data feed, the setup panel
displayed in Fig. 2-7 is used.  In contrast, if a user is connecting to a real-time
ETMS data feed the setup panel in Fig. 2-8 is used.  A description of each of these
panels follows.

When connecting to the live ASDI data feed, the user can either connect directly
to the feed via a socket, or indirectly through FACET’s Traffic Information Proxy
Server (TIPS) process.  Under normal operating modes, both connection
procedures will give the end user exactly the same results.  The advantage of
using TIPS cannot be fully realized unless an error occurs and FACET is forced to
shut down.  Under these circumstances, TIPS can rapidly return FACET to its
pre-failure state, since TIPS archives the most recent ASDI tracks and flight plans
in a temporary buffer.  To invoke TIPS, the user must first start the TIPS process
(see $FACET_HOME/util/traffic_proxy), then optionally select the “Request
Start Time From TIPS” checkbox appearing in Fig. 2-7 for Absolute or Relative
start times. The View Available Data button allows the user to see how much
data is stored in TIPS.

From the dialog box appearing in Fig. 2-7, the user can also set the server
address, port, user id, and password that are required for connecting to the data
feed.  The rate at which the aircraft positions are updated on the FACET display
can be controlled via the “Trajectory Update Interval” text box.  The default
value for this field is 60 seconds.  As in the other FACET modes of operation, the
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user can also choose to filter extraneous altitude messages by selecting the “Filter
Altitudes” checkbox.

\

Figure 2-7: Live Setup Panel for ASDI

When FACET is operated with live ETMS data, an intermediate process called
EDR is used to connect directly to the ftm_connect process running on the local
TSD hardware.  This intermediate process, EDR, reformats the binary data from
ftm_connect to conform with the format of the ASDI message set.  This
reformatted data is then written to a flat file on a regular basis (typically once
every minute).  Using the setup panel shown in Fig. 2-8, the user should specify
the prefix of the reformatted flat files, the time between subsequent file reads and
the directory where the flat files will be located.  When reading ETMS data
formatted in the ASDI convention, the “ASDI” radio button should be selected
on the dialog box shown in Fig. 2-8.  Finally, the input altitude messages can be
filtered for spurious data points by selecting the “Filter Altitudes” checkbox.
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\

Figure 2-8: Live Setup Panel for ETMS

2.2.2 Preferences

Selecting the Preferences menu item from the Simulation menu, will display the dialog
box shown in Fig. 2-9.  This dialog can be used to save, load or restore FACET system
preferences.  To load pre-existing system preferences, either type the preference file
name in the text field or select the “Choose” button and select the preference file to load.
To save the existing FACET preferences, specify the name of the preference file and
select the “Save” button.  To restore the system to the default settings, select the “Restore
Defaults” button.  Currently preferences can be stored for Aircraft Filters, Aircraft
Display Setup (i.e. symbols and data tags), and Airspace Setup (e.g. centers, Special
Usage Airspaces, geographic boundaries, altitude slices and time zones).

\

Figure 2-9: Preferences Setup Panel
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2.2.3 Navigation Law

When FACET is operating in the simulation mode, flights can be made to fly according
to one of the following navigation laws: great circle, Rhumb line, or neighboring optimal
wind routing.  A user can select between these navigation laws by selecting one of the
Navigation Law menu items shown in Fig. 2-10.  The default navigation law is great
circle navigation.  Under Rhumb line navigation, an aircraft will fly a fixed heading
between flight plan nodes, while wind optimal routing between the aircraft’s origin and
destination will be used if the Neighboring Optimal Wind Route menu option is selected.
For additional information about any of these navigation laws, please contact a member
of the FACET/SWEPT development team at NASA Ames Research Center.

\

Figure 2-10: Navigation Law Menu Items

2.2.4 Create Aircraft

When FACET is being operated in the simulation mode, a new user-created aircraft can
be added to the simulation by accessing one of the menu items displayed in Fig. 2-11.
An example of the dialog box that results from selecting the Flight Plan Route menu
items is shown in Fig. 2-12.

\

Figure 2-11: Create Aircraft Menu Items

Creating a new aircraft in a pre-existing simulation requires a user to enter the aircraft ID,
aircraft type, ground speed, cruise altitude, heading, initial flight plan waypoint, and
flight plan via the dialog box appearing in Fig. 2-12.  After entering data in each of these
fields, the user can select the “Add Aircraft” button to add a new aircraft to the
simulation.  For example, to fly an aircraft from SFO to DFW on a direct route at FL370,
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typical input parameters might be as follows: acid=NASA1, type=B737, ground
speed=413, cruise alt =37,000, heading=90, initial waypoint=SFO, flight
plan=SFO..DFW.

\

Figure 2-12: Create Flight Plan Aircraft Dialog Box

2.2.5 Record

From the Record menu shown in Fig. 2-13, a user can write aircraft position data to a
FACET format flat file in any of FACET’s four modes of operation (i.e. simulation,
playback, hybrid, and live).  Options are available for writing either current aircraft
positions or FACET predicted positions to a file.  Upon selecting any of the five submenu
items under the Record menu the user is presented with a dialog box that can be used to
specify the output file.  When appropriate additional information, such as a Center name,
may be requested from the user prior to initiating the data recording process.  The data
recorded as a result of selecting one of these menu items is typically used for system
analysis in a third party package.

\

Figure 2-13: Record Data Menu Item

2.3 Airspace

From the Airspace menu shown in Fig. 2-14, a user can select various airspace overlays
and display options that modify the main FACET window.  Types of overlays include
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Centers, sectors, geographical boundaries, jet routes, waypoints, airports, winds, and
weather.  A description of each of these overlay options follows.

\

Figure 2-14: Airspace Menu

2.3.1 Airspace Setup

The Airspace Setup dialog box is shown in Fig. 2-15.  From this dialog box, seven
different tabs can be selected to choose any of the following map overlay items: centers,
fixes, airways, SUAs, sector/center boundaries, miscellaneous display elements, and
three-dimensional display elements.  The exact layout and display of the tabs on which
these elements are selected is platform dependent, so minor deviations from Fig. 2-15
may be observed.

\

Figure 2-15: Airspace Dialog Box - Center Tab

2.3.1.1 Airspace Dialog: Centers
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From the dialog box shown in Fig. 2-15, a user can select a particular domestic U.S.,
Canadian, European, or oceanic center to display.  A user can also choose to display only
the selected center without drawing the surrounding center boundaries by selecting the
“Center Only” checkbox.  If for example, a user selected the Fort Worth Center for the
list of available centers, the main FACET display would appear as in Fig. 2-16.

Figure 2-16: Fort Worth Center Display

2.3.1.2 Airspace Dialog: Fixes

All intersections and navigation aids in FACET’s airspace adaptation databases can be
displayed via the Fixes tab that is shown in Fig. 2-17.  As an example, the “Show
Navigation Aids” checkbox has been selected in this figure. Clicking on any navaid
results in display of it’s name in the message area at the bottom, along with the victor
airways and jet routes that pass through that point in parenthesis. The latitude/longitude
for that point are also include in square brackets.
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Figure 2-17: Fixes Display Tab and all Navigation Aids

2.3.1.3 Airspace Dialog: Airways

All victor airways and jet routes in FACET’s airspace adaptation databases can be
displayed via the Airways tab that is shown in Fig. 2-18.  As an example, the “Show Jet
Routes” checkbox has been selected in this figure.
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Figure 2-18: Airways Display Tab and all Jet Routes

2.3.1.4 Airspace Dialog: SUAs

All special use airspaces (SUAs) that are available in FACET’s airspace adaptation
databases can be displayed via the SUA tab that is shown in Fig. 2-19.  These adaptations
are obtained from NFDC. The SUAs are divided into the following six categories: Alert,
MOA, Warning, Restricted, Prohibited, and User-Defined.  Selecting on any one of these
check boxes will show the corresponding set of SUAs.  As an example, all Warning areas
are being displayed in Fig. 2-19.  Selecting the “Edit” button adjacent to any of these
SUA categories will display a list of the SUAs in that category with the corresponding
latitude and longitude boundaries.  Based on the current time and SUA activation data
appearing in the airspace adaptations, FACET can also estimate the number of SUAs that
are currently active by selecting the “Show Active SUAs” checkbox. FACET displays
only those active SUAs which have non-ambiguous activation times. The SUAs that
become ‘hot’ intermittently or by NOTAMs are not shown. The User-Defined SUAs are
described in Section 2.5.12.
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Figure 2-19: SUA Display Tab and all Warning Areas

2.3.1.5 Airspace Dialog: Boundary Alt.

From the Boundary Alt. Tab of the Airspace Display Setup panel that is shown in Fig. 2-
20, a user can display the low, high, and super-high altitude sector boundaries for the
U.S. Canada, Europe, and Oceanic regions.  In this figure, all high altitude sectors in the
domestic U.S. are also being displayed for illustrative purposes.  Selecting between the
various sector types is accomplished by selected one of the corresponding check boxes.
For example, the “Sector: High” checkbox was selected to produce the display in Fig. 2-
20.
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Figure 2-20: Boundary Alt. Tab with all High Altitude Sectors

Additional information, such as sector capacities, min/max sector flight levels, and sector
names, for any of the Centers can be obtained by selecting the “View Boundaries” button
appearing on the Boundary Alt. tab.  As an example, Sector 85 in the Chicago Center is
highlighted in green in Fig. 2-21. By selecting ‘Hide Sectors’, all the non-selected sectors
are not drawn. Multiple sectors can be selected by depressing the ‘control’ button.

Figure 2-21: View Boundaries Dialog Panel with Chicago Sector 85 Highlighted
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2.3.1.6 Airspace Dialog: Misc.

From the Misc. Tab of the Airspace Display Setup panel that is shown in Fig. 2-22, a user
can display latitude/longitude grids, U.S. state boundaries, North Pacific coastal
boundaries, sector names, time zones, and overloaded sectors.  Any of these display
options can be invoked by selecting the checkbox appearing next to the map overlay
name.  As an example, the time zones in the U.S. are being displayed in Fig. 2-22.

Figure 2-22: Misc. Tab with Time Zones Displayed

2.3.1.7 Airspace Dialog: 3D

The main controls for the three dimensional FACET displays are in the 3D tab that is
located in the Airspace Dialog Setup panel.  Prior to utilizing any of the options available
on this tab, the 3D View menu item that is discussed in Section 2.3.9 must be selected.
Figure 2-23 contains an image of the 3D tab with the vertical profiles of the ORD
arrivals.  The vertical slider bar on the right can be used to move the entire view up or
down. From the 3D tab, a user can toggle between the 2D planview display and the 3D
display by selecting either the “Plan” or “Side” buttons.  In a perspective view, the
altitude of aircraft can be visualized by checking the “Show AC Height Lines”, The
altitude axes, which are displayed in this figure, can be toggled on and off via the “Show
Axes” checkbox.  To rotate the display about the z-axis, a user first selects the “Allow Z
Rotation” checkbox, then uses the mouse to rotate the display. The rotation actions can be
undone and the view restored by pressing the “Rotate” button.  Automated rotation of the
display can be accomplished by selecting the “Animate 3D Image” checkbox.  The
display animation settings are accessible via the “Setup” button.  Since the rotation of 3D
trajectories is computationally intensive, the user is advised to pause the updating of new
aircraft position information prior to selecting the “Animate 3D Image” checkbox. The
“View 2D Window” functionality is under construction and should not be used. If Center
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or sector boundaries are displayed, they can be viewed as wireframes or polygons by
selecting the appropriate radio buttons on the right.

Figure 2-23: 3D Tab with ORD Arrivals Displayed

2.3.2 Show Wypt/Airway

The display of individual airports, waypoints, navigation aids and airways can be
accomplished via the “Wypt/Airway Display” panel that is accessible from the Show
Wypt/Airway menu item (see Fig. 2-14).  The Wypt/Airway Display panel is shown in
Fig. 2-24 along with the main FACET display.  For illustrative purposes, the Dallas/Fort
Worth International Airport is being displayed.  After entering a waypoint, airport, or
airway into the available text field, a user can display the element by selecting “Add” or
simply lookup the elements name by selecting “Find”.  The colors of elements can be
changed by selecting on the “Color” field appearing in the list of displayed waypoints and
airways.  The names of elements can also be displayed by selecting the “Show Names”
checkbox.  Capabilities also exist to draw a set of concentric circles about either an
airport or waypoint.  This is accomplished by selecting the “Show Rings” button. The
“Dept Fixes” button shows the departure fixes found in FACET’s CDR database around
major airports. All of these settings can be saved in a file for later retrieval.
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Figure 2-24: Show Wypt/Airway Panel

2.3.3 Show Flight Plan

The display of individual flight plans can be accomplished by using the “Flight Plan
Display” panel that is accessible from the Show Flight Plan menu item in the Airspace
menu (see Fig. 2-14).  The Flight Plan Display panel is shown in Fig. 2-25 along with the
main FACET display.  For illustrative purposes, the following flight plan is being
displayed: DFW.DALL7.TXK.J42.MEM.J42.BKW.JASEN4.IAD/0207.  In addition to
manually entering individual flight plans to display, a user can also read in lists of flight
plans to display by specifying an input file via the File menu on this panel.  Displayed
flight plans can be individually removed by first highlighting the flight plan, then press
the “Remove” button.  All currently displayed flight plans can be removed by pressing
the “Remove All” button.
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Figure 2-25: Show Flight Plan Panel

2.3.4 Zoom

A user can zoom-in and -out of the FACET display by selecting any of the menu items
appearing in the Zoom menu that is shown in Fig. 2-26.  Though this functionality still
operates properly, the preferred method to zoom-in and –out of the FACET display is by
using the magnifying glass icons that appear on the FACET toolbar. The last item,
“Select tangency point” can be used to move the point of tangency to any location by
clicking on the main FACET display.

Figure 2-26: Zoom Menu Items
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2.3.5 Altitude Slice

The “altitude slice” at which low- and high-altitude sectors are displayed in 2D and 3D
views can be adjusted via the “Altitude Slice” panel that is shown in Fig. 2-27.  The
default settings at to display the low-altitude cross sections at FL180 and the high-altitude
cross sections at FL350.  These default settings can be changed by directly entering the
new flight levels, or by moving the slider bars.  After changing the default settings, press
the “Accept” button to implement the changes. Selecting “Fill Holes” allows filling of
gaps in low altitude sectorization with definitions from high altitude sectors and vice
versa.

Figure 2-27: Altitude Slice Panel

2.3.6 Choose Colors

Selecting the Choose Colors menu item, from the Airspace menu, results in the display
of the color selection panel that is shown in Fig. 2-28.  From this panel, a user can change
any of the following colors: FACET background, US Boundary, Center Boundaries,
Sector Boundaries, and Time Zones.  To change the color of any of these items, the
following steps should be performed:

• Select the item that will be changed from the available list
• Press the “Color” Button and select the new color from the color palette
• Press the “Apply” button to select the color change or the “Cancel” button to

discard the color change
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Figure 2-28: Choose Colors Panel

2.3.7 Change Fonts

Selecting the Change Fonts menu item, from the Airspace menu, results in the display of
the font selection panel that is shown in Fig. 2-29.  From this panel, a user can change the
font that is used to display the label of any of the following: Airports, Non-Standard
Navigation Aids, Aircraft Data Tags, Airway Intersections, Navigation Aids, and Fixes.
To change the font associated with any of these items, the following steps should be
performed:

• Select the item that will be changed from the available list
• Choose the new font style from the available list
• Press the “Apply” button to implement the font change or the “Close” button to

close the panel and discard the font change

Figure 2-29: Change Font Panel

2.3.8 Weather

Selecting the Weather menu item, from the Airspace menu, results in the display of the
weather panel that is shown in Fig. 2-30.  From this panel, a user can read and display
RUC winds, CIWS, CCFP, NCWF, and NOWRAD data.  A description of each of the
available weather panels follows.
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2.3.8.1 RUC Winds: Data Source

From the main Rapid Update Cycle (RUC) display that is shown in Fig. 2-30, a user can
load either a RUC or a Global Forecast System (GFS) wind file into FACET.  For
operations over the domestic U.S. the RUC winds are preferred, while the GFS winds are
preferred when considering oceanic operations.  Selecting between these two types of
wind files is accomplished via the “USA Wind Model” and “Global Wind Model” radio
buttons appearing on this panel.  After selecting the appropriate wind file type, the user
should press the “Read RUC” button to initiate the reading and processing of the wind
file.  Once a wind file has been read into FACET, the wind data can be displayed and
used in the trajectory calculation process.
To determine which wind file will be read in after the “Read RUC” button is pressed,
FACET reads the contents of the $FACET_HOME/user/wthr/RUCRendezvous.  This file
should contain the name and relative path of the actual RUC/GFS wind file to read.  A
sample RUCRendezvous entry follows: Weather/ruc2.T13Z.pgrbf01.  Upon reading this
entry from the RUCRendezvous file, FACET will search the
$FACET_HOME/user/wthr/Weather directory for a file called ruc2.T13Z.pgrbf01, which
is a one-hour RUC forecast file that was created at 13:00 UTC and is valid at 14:00 UTC.
After an initial file has been read in, FACET will periodically re-examine the
RUCRendezvous file to determine if a new wind file is to be read in.
As of the creation date of this document, the “# of Files”, “Select File”, and “Use
RUCRendezvous” fields appearing on this panel have yet to be fully implemented.  These
capabilities are expected to be available in future versions of the software.
After reading in a wind file, the wind vectors and select atmospheric parameters can be
displayed via one of the following tabs on the RUC panel: “Isobaric Winds”, “Wind
Wireframes”, and “Other Variables”.  A brief description of each of these panels follows.
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Figure 2-30: RUC Data Source Panel

2.3.8.2 RUC Winds: Isobaric Winds

From the “Isobaric Winds” panel, a user can display the magnitude and direction of
RUC/GFS winds at pressure levels ranging from 100mb to 1000mb.  An example in
which the winds are being displayed at 225mb, which corresponds to a flight level range
of 358 to 385 at the time of validity, is shown in Fig. 2-31.  Alternative pressure levels
can be selected via the drop down menu adjacent to the “Isobaric Level” text field in this
figure.  Though Fig. 2-31 is displaying the winds as contours, three additional display
methods are also available for visualizing the winds.  A user can select between any of
these display methods by toggling the appropriate radio button.  The legend and color
guide on this panel can be used to correlate the wind colors on the FACET display to the
actual wind speed.  For visualization purposes, a user can also animate the display of the
winds between user selectable upper- and lower-pressure levels.  These animation
capabilities can be invoked by selecting the “Animate” checkbox.  Setup of the animation
is accomplished via the animation setup panel that is displayed after depressing the
“Setup” button.
After selecting the pressure level at which to view the winds and wind display mode, the
user should select the “Display” button to view the winds on the FACET display.
Clearing the wind display is accomplished by selecting the “Clear” button. The wind data
can also be viewed in 3D View mode to see how wind magnitudes increase with altitude.
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Figure 2-31: RUC Data Isobaric Winds Setup/Display

2.3.8.3 RUC Winds: Wind Wireframes

Wind wire-frames, or contours, can be displayed for user specified threshold values from
the “Wind Wireframes” panel.  This panel and the contours for all winds greater than or
equal to 75 knots are displayed in 3D View mode (???) in Fig. 2-32.  The available wind
threshold values are 60, 75, 90, 105, and 120 knots.  The threshold value to display is
selectable via the “Threshold” drop-down menu.  Either sparse or non-spare wire-frames
can be used when displaying the contours depending on whether the “Sparse
Wireframes” checkbox has been selected.  After selecting the threshold value of interest,
the wireframes can be displayed by selecting the “Display” button.

Figure 2-32: RUC Data Wind Wireframes Setup/Display

2.3.8.4 RUC Winds: Other Variables
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Additional variables available in the RUC wind files, such as CAPE, CIN, PWAT, and
SSRUN, are available for display via the “Other Variables” panel that is shown in Fig. 2.-
33.  Either the raw binned data or contours of the data can be displayed from this panel.
As an example, the CAPE parameter and contours greater than or equal to 100 J/kg are
being displayed in this figure.

Figure 2-33: RUC Data "Other Variables" Setup/Display

2.3.8.5 CIWS

MIT Lincoln Laboratory’s (MITLL) Corridor Integrated Weather System (CIWS) data
can be displayed via the “CIWS” panel that is shown in Fig. 2-34.  The CIWS file that
FACET reads should be specified in either the
$HOME_FACET/user/wthr/CIWSRendezvous or the
$HOME_FACET/user/wthr/CIWSNetCDFRendezvous file.  The content of either of
these files is simply a list of the CIWS files that FACET should read.  From the panel
shown in Fig. 2-34, a user can read “Standard CIWS” or “NetCDF CIWS”.  The
“Streamed CIWS” option should not be used, since it requires a direct connection to a
machine from MITLL that is displaying real-time CIWS data.
The “Past/Current/VIL” portion of the display is used to select the Vertical Integrated
Liquid (VIL) levels that are displayed for either the current or past CIWS data.  If the
VIL levels are to be displayed, the “Show VIL” checkbox should be selected.  By default,
the VIL levels are not displayed.  The forecasted probability of level 3 or higher
convective weather can be displayed by selecting the appropriate setting in the “Forecast”
region of this setup panel.  Note that the user must be displaying one of the forecasted
products (e.g. FCST030) in order to view these forecasted probabilities.  Echo tops can
also be displayed by first selecting the “Show Echo Tops” checkbox and then selecting
the levels at which the tops should be displayed.
For the current, historical, and forecast products, either the raw CIWS map or a contoured
map can be displayed.  Animation loops of the weather products can be created by
selecting the “Animate” checkbox and entering user preference via the “Setup” panel that
is accessible after pressing the “Setup” button. The “Show product time” and “With date”
buttons can be checked for data validity time and date.
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Figure 2-34: CIWS Setup/Display

2.3.8.6 CCFP

The panel used to read and display the Collaborative Convective Forecast Product
(CCFP) is shown in Fig. 2-35.  The CCFP file that FACET reads is specified in the
$FACET_HOME/user/wthr/CCFPRendezvous file.  This file should contain one entry
that specifies the name and local path of the CCFP file to read.  After updating
CCFPRendezvous, press the “Read CCFP” button to import the data into FACET.  After
reading in a CCFP file, the list of areas that are available for display appear in the list
shown in Fig. 2-35.  Selecting any of the areas in the list will result in the area being
drawn on the FACET display in accordance with the confidence/coverage legend shown
in this figure.  To monitor the flow of aircraft through this region in either the simulation
or live-modes, simply press the “Set up monitoring” button, and follow the onscreen
instructions.
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Figure 2-35: CCFP Setup/Display

2.3.8.6 NCWF

The panel used to read and display the National Convective Weather Forecast (NCWF)
Product is shown in Fig. 2-36.  The NCWF file that FACET reads is specified in the
$FACET_HOME/user/wthr/NCWFRendezvous file.  This file should contain one entry
that specifies the name and local path of the NCWF file to read.  After updating
NCWFRendezvous, press the “Read NCWF” button to import the data into FACET.
Displaying and clearing the NCWF data is accomplished by selecting the “Display” and
“Clear” buttons shown in Fig. 2-36.

Figure 2-36: NCWF Setup/Display
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2.3.8.7 NOWRAD

The panel used to read and display the NOWRAD weather data is shown in Fig. 2-37.
The NOWRAD file that FACET reads is specified in the
$FACET_HOME/user/wthr/NOWRADRendezvous file.  This file should contain one
entry that specifies the name and local path of the NOWRAD file to read.  After updating
NOWRADRendezvous, press the “Read NOWRAD” button to import the data into
FACET.  Displaying and clearing the NOWRAD data is accomplished by selecting the
“Display” and “Clear” buttons shown in Fig. 2-36.  Low-intensity storm activity can be
filtered from the FACET display by utilizing the checkboxes that correspond to the
various storm intensity levels.

Figure 2-37: NOWRAD Setup/Display

2.3.9 3D View

To activate the three dimensional (3D) traffic and airspace display capabilities, select the
3D View menu item from the Airspace menu that is shown in Fig. 2-38.  After selecting
this menu item, the 3D Setup Panel that was discussed in Section 2.3.1.7 can be used to
control the 3D display.
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Figure 2-38: 3D View Menu Item

2.3.10 Sector Mods

From the Sector Mods menu that is displayed in Fig. 2-38, a user can modify the
geometry of a Sector, undo recent sector boundary modifications, store modified sector
geometries, and load previously modified or original sector boundary modifications.  All
sector boundary modifications are accomplished via intuitive interactions with the
FACET display.

Figure 2-39: Sector Modification Menu

An example in which the boundary of a high-altitude sector in the Fort Worth ARTCC is
modified is shown in Fig. 2-40.  After selecting the Modify Sector Boundary menu item
that is shown in Fig. 2-39, the user should follow these steps to modify a boundary:

• Select a sector node to move by clicking the mouse on it (a green circle appears
around it)

• Drag the node to a new location
• Select “Accept” or “Cancel” from the menu in Fig. 2-40 to keep or discard the

changes
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From the Sector Modification menu in Fig. 2-40, a user can also add new nodes to a
boundary or delete any of the displayed nodes.  To exit the sector modification mode,
reselect the Modify Sector Boundary menu item that is shown in Fig. 2-39.

Figure 2-40: Sector boundary modification example

2.4 Aircraft

From the Aircraft menu shown in Fig. 2-41, a user can set all attributes that influence the
way in which flights are drawn on the FACET display.  A description of each of these
menu items follows.

Figure 2-41: Aircraft Menu
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2.4.1 Display Symbol

From the Display Symbol menu shown in Fig. 2-42, the default shape used to represent an
aircraft on the FACET display can be selected.  As can be seen from this menu, the list of
available shapes includes a triangle, an aircraft image, a dot, a dot with a heading
indicator, and a pixel.  A menu item also is available to draw aircraft with identical
symbols.  If this menu item is not selected, then FACET will use different symbols to
represent flights that have not received a flight plan (a circle) or flights that are being
coasted either along the flight plan (a lower case letter c) or along a “dead-reckoning”
trajectory (an asterisk).

Figure 2-42: Display Symbol Menu

2.4.2 Aircraft Tag

From the Aircraft Tag menu shown in Fig. 2-43, a user can select the elements that are
displayed in the flight data block (FDB).  By default, only the aircraft identifier is
displayed in the FDB.  As can be seen from this menu, the aircraft type, altitude, speed,
heading, origin/destination, flight plan, beacon code, and ETMS ID are also available for
display in the FDB.  To display any of these additional elements in the FDB, simply
select the menu item corresponding to the element that is to be added to the FDB.
Alternatively, all available FDB elements can be displayed by selecting the Select All
menu item.
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Figure 2-43: Aircraft Tag Menu

2.4.3 Range Rings

From the Range Rings menu shown in Fig. 2-44, a user can elect to display a circle or a
group of concentric circles around an individual aircraft or all aircraft on the FACET
display.  Modifying the radius of the circle or the number of displayed circles can be
accomplished by selecting the Range Ring Setup menu item and following the on-screen
directions.  If a range ring is to be displayed for an individual aircraft, the user must first
select the Select Aircraft menu item then select the appropriate aircraft on the FACET
display.

Figure 2-44: Range Ring Menu

2.4.4 Trend Vector

From the Trend Vector menu shown in Fig. 2-45, a user can elect to display a trend
vector for an individual aircraft or all aircraft on the FACET display.  Modifying the
look-ahead time of the trend vector can be accomplished by selecting the Trend Vector
Setup menu item and following the on-screen directions.  If a trend vector is to be
displayed for an individual aircraft, the user must first select the Select Aircraft to Apply
Trend Vector menu item then select the appropriate aircraft on the FACET display.
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Figure 2-45: Trend Vector Menu

2.4.5 Histories

By selecting the Histories menu item under the Aircraft display, the “Aircraft History
Setup” panel that is shown in Fig. 2-46 can be accessed.  From this panel, a user can
select the duration of histories that are displayed for selected flights.  By default, the
entire history for a flight is displayed.  To limit the display, first select the “Limit History
Length” checkbox then use the slider menu or the text field to set a history length of up to
two hours.  Display of aircraft histories can be activated via the FACET toolbar, the
“Filter” panel, or the Show menu item (see Section 2.4.10) under the Aircraft menu.

Figure 2-46: Flight History Setup

2.4.6 Filter

By selecting the Filter menu item under the Aircraft menu, the “Aircraft Filter” panel
that is shown in Fig. 2-47 can be accessed.  Aircraft can be categorized and displayed
based on the following characteristics: aircraft identifiers, airline, type, origin,
destination, flight level, center, sector, jet route, origin center, destination center, fix,
weight, equipage, length of flight (i.e. “Haul”), and delay.  Each of these identifiers can
be used separately or in conjunction with other identifiers.  For example, to filter all
Northwest flights starting in Minneapolis Center and going to Atlanta Center, the
following parameters would be used: airline=NWA, Origin Center=ZMP, and
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Destination Center=ZTL. These filters are used with ‘and’ and not ‘or’ logic. Therefore,
setting the origin center as ZMP, and origin (airport) as LAX will not yield any results.
The color used to filter flights can be selected via the “Choose” button under the Filter
Attributes.  The currently selected color is displayed adjacent to the “Choose” button
(currently set to cyan).  Selecting the “Aircraft Symbol” drop down menu can change the
type of symbol used to represent each filtered flight.  In addition, the amount of
information to display for each flight (e.g. symbol, history, flight plan, and data tag) can
be selected via the provided checkboxes.  After setting the filter parameters and
attributes, select the “Add Filter” button to implement the filter.  A list of all
implemented filters will appear in the “Applied Filters” list.  Selecting any of the applied
filters, will allow the filter attributes to be modified.  Similarly, a filter can be removed
by first selecting the filter from the list of applied filters then selecting the “Remove
Filter” button. On selecting the “Display” button under Aircraft List column for any
filter, allows the user to view the list of flights covered by that filter. This list can be
written to a file instantaneously or continuously as new data is processed.
Additional predefined filters also exist at the bottom of the “Aircraft Filter” panel for
displaying (1) Duplicate Aircraft, (2) “Out-Of-Bounds” Aircraft, and (3) Limiting the
display of flights to only the filtered aircraft, which displays only filtered aircraft on the
FACET display.  A legend of all existing filters and the number of aircraft impacted by
each filter can be displayed on the main FACET canvas by selecting the “Display
Legend” checkbox.
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Figure 2-47: Flight Filter Setup Panel

2.4.7 Browser

By selecting the Browser menu item under the Aircraft menu, the “Browser” panel that
is shown in Fig. 2-48 can be accessed.  From this panel, detailed information about any of
the flights currently available in FACET can be obtained.  Selecting an aircraft from the
list of available aircraft will result in the aircraft being highlighted on the FACET display
and the “General”, “FlightPlan”, “Location”, “Time”, and “Other” panels will be updated
with the current state information.  As an example, AAL1017 has been selected from this
list and the “General” panel indicates that the plane type is an MD83, current latitude is
41.11 degrees, current longitude is 266.98 degrees, current flight level is 240, heading is
249.3 degrees, and the filed altitude was 24,000 ft.  By default the selected aircraft will be
highlighted red and the data tag will be displayed.  Additionally, the aircraft’s flight plan
and history can also be displayed.  Displaying either of these elements can be
accomplished by selecting the “Show FP” and “Show Hist” checkboxes, respectively.
The color of the filtered aircraft can also be changed by selecting the button located in the
center of the colored rectangle.
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Figure 2-48: Browser Panel

2.4.8 FP Database

Selecting the FP Database menu item from the Aircraft menu can be used to access the
“Flight Plan Database” panel that is shown in Fig. 2-49.  From this menu, a user can
connect to a MySQL database, write data to the database, clean-up the database, and save
an existing database to a file.  By default, FACET attempts to connect to the flight plan
database using the DB_ADDRESS, DB_USERNAME, DB_PASSWORD, DB_NAME,
and DB_CONNECT parameters that are specified in
$FACET_HOME/facet/init/facet.config file.  Default values for each of these parameters
are as follows:

• DB_ADDRESS=localhost
• DB_USERNAME=facet_client
• DB_PASSWORD=core.facet
• DB_NAME=facet
• DB_CONNECT=connect

Writing to the database can be accomplished in any of FACET modes (i.e. playback,
simulation, hybrid, or live) by first selecting the “Write to database” checkbox then by
starting the desired mode of operation.  Since database records for an entire day can
approach 400Mb, the “Database cleanup” button can be used to remove unwanted data
from the database. Another way of reducing data is to “Configure” the database to write
track data for only selected flights (matching either acid, type, origin, or destination) or
not writing track data at all. In the former, a space separated list with wildcard characters
is acceptable syntax (e.g. aal* nwa* etc. for acid field)
Once a connection to the database has been established, a database query can be
constructed by specifying any or all of the following: aircraft identifier, origin,
destination, aircraft type, flight plan, and record start/end time.  As an example, all flights
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originating in SJC that are destined for DFW are shown in Fig. 2-49.  By default only the
aircraft identifier and the flight plan are displayed in the list of filtered flights.  In
addition, the FACET-assigned unique identifier, the origin, destination, and aircraft type
can also be displayed by selecting the appropriate checkboxes.  To display any of the
filtered flights, simply select the flights to display then select the “Display selected flight
plans/histories” checkboxes.
Information about the ETAs, proposed departure times, and sector usage statistics can
also be obtained for individual flights or groups of flights.  To obtain any of these
statistics the following steps should be completed:

• Step 1: Select the flight(s) from the flight list
• Step 2: Select the “Compute event statistics for selected flights” checkbox
• Step 3: Select “Sector Entries” tab

As can be seen in the example shown in Fig. 2-49, AAL1966 occupied ZFW Sector 47,
ZFW Sector 75, ZFW Sector 93, ZFW Sector 98, and ZFW TRACON.  The minimum,
maximum, and mean sector entry statistics are also displayed.  Since only one flight was
selected in Fig. 2-49, each of these fields represents the statistics for a single aircraft. By
selecting “View list” or “View histogram”, individual flight date/time or a histogram of
statistics can be seen.

Figure 2-49: Flight Plan Database Panel
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2.4.9 Modify a Flight Plan

To manually modify the flight plan of an individual aircraft, in either the live or the
simulation mode, the following steps should be followed:

• Select the Modify a Flight Plan menu item from the Aircraft menu
• Select the aircraft to be modified using the mouse button

After completing these steps, the flight plan modification panel and the modified FACET
display shown in Fig. 2-50 will be displayed.  A user can either manually enter a new
flight plan via the panel, or graphically modify the flight plan on the FACET display.
When graphically editing the flight plan, new elements can be added by first selecting the
“Add waypoint” checkbox then clicking on the FACET display in the location of the new
flight plan.  Similarly, existing nodes on a flight plan can be moved by first selecting an
existing node then dragging the node to a new location.  The modified flight plan can be
accepted by selecting the “Done” button or rejected by selecting the “Cancel” button.  To
eliminate all user modifications and revert to the original flight plan, the “Ignore all user
changes” checkbox should also be selected.

Figure 2-50: Modify Flight Plan Dialog/Display

2.4.10 Show

The Show menu items from the Aircraft menu are displayed in Fig. 2-51.  From these
menu items, the user can (1) Show all aircraft, (2) Show all flight plans, (3) show all
histories, (4) show all data blocks, and (5) enable the flight data blocks to be
automatically displayed with a mouse over.  The default settings are to show all aircraft
and to allow the flight data blocks to be displayed when highlighted with the mouse.
Since these settings impact all flights on the FACET display, care should be taken when
displaying all flight plans, histories and data blocks to avoid screen clutter.
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Figure 2-51: Show Menu Items

2.4.11 Clear

The Clear menu items from the Aircraft menu are displayed in Fig. 2-52.  From these
menu items, the user can (1) Clear all flight plans, (2) Clear all data blocks, or (3) Clear
all histories.

Figure 2-52: Clear Menu Items

2.5 Applications

From the Application menu shown in Fig. 2-53, a user can access the major applications
that have been developed for FACET.  These applications include, among other things,
capabilities for calculating sector/center usage, displaying aircraft attributes, monitoring
and avoiding FCAs, and invoking traffic flow management restrictions.  A description of
each of these menu items follows.
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Figure 2-53: Applications Menu

2.5.1 Plot Data

Selecting the Plot Data menu item from the Application menu can access the “Plot
Data” setup panel that is shown in Fig. 2-54.  This panel allows management of current
plots in simulation, playback, or live modes. There are no restrictions on when plots can
be added or removed. When FACET execution is restarted, all data is removed from
plots. Closing the Plot Data panel does not affect the plots.
The panel contains two boxes, 'Create New Plot' and 'Current Plots'. The first is used to
configure a new plot. For example, to plot the number of aircraft over the United States,
under the 'Calculations' tab, select 'Number of aircraft' vs. time, and choose 'Aircraft over
continental US' radio button. To create a new window containing this plot, click 'Add to
new window ->'. To add the plot to an existing window, select the desired window in the
list and click 'Add to _window name_ ->'. To remove a plot or window, select it in the list
and click 'Remove'. Removing all plots from a window closes the window. To view the
parameters of an existing plot, select it in the list and click '<- View'. While plots already
in the list cannot be edited directly, a plot can effectively be changed by viewing it,
removing the old plot, and adding the plot with changed parameters back to the same
window.
Windows containing plots can be renamed by clicking their name in the list.
The plot parameters are as follows:

• Calculations - Used to create plots of a parameter calculated over a group of
aircraft

o Calculation Selection:
 Number of aircraft: A simple count of aircraft in this group
 Avg. aircraft separation: The mean of the distances between every

pair of aircraft in this group. This calculation is computationally
intensive. No data will be provided when there are fewer than two
aircraft in the group.

o Aircraft Groups:
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 All known aircraft: Includes all aircraft that are listed as Flying or
"Tracks-only" (no flight plan received yet, but apparently flying)

 Aircraft over continental US: Flying and Tracks-only aircraft
whose current center is one of the 20 continental US centers

 Aircraft in center/sector: Flying and Tracks-only aircraft whose
current center or sector equals the name in the text field. Three-
letter center names or letter-number sector names are allowed. The
Choose button allows center or sector selection from a list

 Aircraft in region: Flying and Tracks-only aircraft in the named
region. A region is a collection of sectors, optionally limited to an
altitude range. The Edit button opens the Edit Region dialog to set
up a region. Regions can be saved to or loaded from .rgn files on
disk from within the Edit Region dialog. Selecting a plot in the
Current Plots box that uses a region and clicking '<- View' will set
up the Create New Plot box with a copy of the region. Editing the
region will not affect the plot that already exists.

• Attributes - Used to plot flight attributes for a single aircraft, all known aircraft, or
all aircraft over the continental United States.

o Attribute Selection
 Time - the simulation time in minutes
 Latitude, Longitude - in degrees
 Projected X/Y coord - An aircraft is drawn in FACET by first

projecting its lat/lon position on the surface of the earth onto a 2D
plane using an Oblique Stereographic projection. The projected
coordinates represent the aircraft's position on this plane. Since the
projection can change when zooming or otherwise changing the
FACET display, the projected coordinate values will be affected by
these changes. A warning is displayed the first time projected
coordinates are plotted.

 Altitude - in flight level (hundreds of feet)
 Ground and Air Speed - in knots
 Heading - in degrees
 Flight Plan ETA – flight plan estimated time of arrival
 Departure ETA
 Proposed ETA
 Fuel Burned – fuel burn estimate in pounds
 Path Length – total flight distance in nm
 Path Time – total flight time in seconds

• Aircraft Selection - the ID of the desired aircraft. A comma-separated list of
aircraft IDs will add one plot for each aircraft to the desired window.
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Figure 2-54: Plot Data Setup Panel

Once the parameters of a plot have been defined using the panel shown in Fig. 2-54, a
“Plot Window”, similar to the one in Fig. 2-55 will be displayed. A Plot Window displays
plot data in a graph and provides the ability to save the data to disk. It also provides
options to modify the appearance of the graph.

 File menu:
o Save plot as image: Save the contents of the window (at the current

window size) to an image file. Due to the low-quality JPG compression,
PNG format is recommended.

o Save current data: Save the data contained in the window to a text file.
The save dialog contains a trend selection menu. Selecting one trend from
the menu saves only the data for that trend to the file. Selecting 'All trends'
saves the data for all trends into one text file in ACE/gr (xmgr) format. In
xmgr, load this file by selecting Read->Sets... from the File menu.
Loading the file will automatically set up the set names in the legend.

o Continuously write to file: Continuously write data to files as the data is
received. This menu item displays a dialog to associate trends with output
files. To choose an output file, select a trend from the table and click
'Specify file(s)..'. The save dialog includes a checkbox to include the
trend's current data in the output file. Selecting multiple trends before
clicking 'Specify file(s)..' will apply the selected file, modified by a unique
integer, to each selected trend. The 'Clear selected' button removes file
associations from selected trends. No changes take place until the 'Done'
button is clicked ('Cancel' ignores all changes).

 Options menu: appearance options are self-explanatory
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Figure 2-55: Sample Plot Window

2.5.2 Traffic Density Profile

By selecting the Traffic Density Profile menu item under the Applications menu, the
“Traffic Density Profile” panel that is shown in Fig. 2-56 can be accessed.  This
application can be used in playback, simulation, or live mode to calculate the traffic
density on a uniform grid.  The parameters that are used to define the grid follow:

o Center: USA or Center in which to calculate the traffic density
o Bounding Box:
o Grid Cell Dimensions: Horizontal dimensions of each grid cell in nm
o Flight Level Range: Vertical dimensions of each grid cell in 100s of feet

Once a grid region has been defined, the “Create Grid” button can be selected to initiate
the traffic profiling.  The list of currently defined regions in which to profile the traffic
density is also displayed in Fig. 2-66.  From this list, the display of the traffic density grid
can be toggled on and off.  A representative grid for the Chicago ARTCC is displayed in
Fig. 2-56.  For post processing purposes, the traffic density profile data can be written to
a file by selecting the “Choose” button and following the online instructions.
Please note that this application is in the very early stages of development and is expected
to change frequently.
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Figure 2-56: Traffic Density Profile

2.5.3 Sector Count Analysis

By selecting the Sector Count Analysis menu item from the Applications menu, the
“Sector Count Analysis” panels that are shown in Fig. 2-57 can be accessed.  From these
panels, a user can query the MySQL database that FACET connects to and obtain sector
count statistics for any of the low-, high-, or super-high altitude sectors in the U.S. The
database that FACET connects to in order to accomplish the queries is defined in the
$FACET_HOME/init/facet.config file.  The main parameters in this file that are used to
establish the database connection are as follows:

o DB_ADDRESS: Address of the server to connect to
o DB_USERNAME: The MySQL username used to log into the server.
o DB_PASSWORD: The password for the MySQL use

As can be seen from Fig. 2-57, the “Sector Count Analysis” panel contains three sub-
panels.  A brief description of each of these follows:

o Analysis Panel: Used to obtain historic sector count statistics for either actual
or predicted traffic levels.

o Input Parameters: Specify the sector on which the query is to be
performed and temporal duration of the query (e.g. only Sundays in
January)

o Results: Specifies the average, standard deviation, minimum, and
maximum sector counts

o Query Panel: Defines the historical sector count statistics that are displayed in
the Planning Dialog (see 2.5.7) sector count grid displays

o Selection Fields: Determine what data is used to generate the displayed
historical sector counts
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o Display Fields: Determines what historical sector count data is
displayed.

o  Admin Panel: Allows an individual to manage what data is written to the
database and how often the data is written to the database

Figure 2-57: Sector Count Analysis Panels

2.5.4 “Messenging Manager”

The “Messenging Manager” application that is accessible via the Messenging Manager
menu item in the Application menu is currently still under development and should not
be selected.  Once completed, this application will allow distributed FACET users to
communicate via a simple “Instant Messenger” like interface.

2.5.5 Center Statistics

By selecting the Center Statistics menu item from the Applications menu, the “Center
Statistics” panel that is shown in Fig. 2-58 can be accessed.  The “Center Statistics”
application is the predecessor to the “Plot Data” application that was discussed in Section
2.5.1 and is for the most part used for research purposes.
The calculation setup parameters for this panel follow:

o Display Statistics For: Drop down list allows a user to select between aircraft
counts, dynamic density, avoidance counts, and sector overload displays

o Select a Center: Drop down list allows selection of one of the U.S. Centers
o Altitude Choice: Used to specify the altitude stratum to monitor
o Sector Choices: Used to select the sectors for which statistics are calculated
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o Selected Sectors: Contains a list of the user selected sectors
o Prediction Interval: Can be set to compute and display the FACET sector

predictions
o Bounding Box Size: Specifies a bounding box around the selected Center from

which additional flight plan/track data can be retrieved.  This setting is only used
if predictions are also being calculated

o Output File: Displays the name of the output file to which the center statistics data
will be written.  The filename is specified in the File->Output File menu.

Figure 2-58: Center Statistics Setup Panel

2.5.6 Distances

By selecting the Distances menu item from the Applications menu, the “Distance
Calculation” panel that is shown in Fig. 2-59 can be accessed.  Using the mouse, a user
can select two points on the FACET display.  The corresponding stereographic, great
circle, and Rhumb line distances between these two points in nautical miles will be
displayed in the appropriate fields in the panel.
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Figure 2-59: Distance Calculation Panel

2.5.7 Planning

By selecting the Planning menu item from the Applications menu, the “Planning Setup”
panel that is shown in Fig. 2-60 can be accessed.  This application is the primary means
by which predictions are calculated and displayed within FACET.  This application can
be used either in live mode or with prerecorded data in the “TRX_” format.
The top-level parameters that are used to define a planning session are as follows:

o Simulation Type: Either “Flight Plan” or “Great Circle”
o Input File: In post-operations, this is used to select the TRX_ file from which the

flight plans, proposed departure times, and initial aircraft positions are selected.
In live mode, this option is not displayed and the aforementioned data set is
constructed from the live input data stream

o Traffic: Used to set the criteria for highlighting counts that increase or decrease as
time progresses.  By default, only counts that increase or decrease by three or
more aircraft are displayed.  Magenta is the default color for indicating count
increases and blue is the default color for indicating count decreases

o New Grid: Selecting this button displays the panel in Fig. 2-61.  This panel is
described in greater detail below

o Stream Insertion: Allows open “slots” in overhead stream to be identified in order
to coordinate departure releases.  This application is only available in live mode.

o Route Evaluation: Allow individual routes to be pre-planned to determine if they
will encounter any congested regions of airspace
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Figure 2-60: Planning Setup Dialog Panel

The “Aircraft Count Grid Setup” panel shown in Fig. 2-61 is used to define what FACET
is performing predictions for.  A description of the various parameters on this panel
follows:

o Data Type: Used to specify if predictions are performed for sectors, airport
arrival/departure rates, fix crossing rates, Flow Constrained Area (FCA) counts,
or sector risk assessment.

o Centers/Sectors: When performing center/sector predictions, this group of fields
allows one to determine which predictions will be depicted in a grid, bar chart or
map.  By default FACET performs predictions for all sectors in the NAS and
these fields are simply used to filter the amount of data that is displayed.  When
performing predictions for airports, fixes, and FCAs, the Center/Sector fields will
be modified appropriately.

o Time Parameter: Used to specify the prediction start time, the duration of the
prediction, and the bin size used for presenting the data (prediction interval size).
By default, FACET uses a 60 second time step when performing the predictions.

o Sector Count Type: Specifies whether deterministic (default) or stochastic
predictions are performed.  When performing stochastic predictions, only the
departure time uncertainty is accounted for using Gaussian distributions.

o Sector Count Method: When displaying the prediction results, either the
instantaneous maximum number of aircraft or the unique number of aircraft in
each prediction interval can be displayed.

o Display: Used to determine specify how the results are presented to the user.
These settings are discussed in more detail below.

After specifying all of the aforementioned prediction setup entries, the “Run” button in
Fig. 2-61 can be pressed in order to initiate the predictions.  Alternatively, the “Ok”
button can be selected and the user will be redirected to the panel shown in Fig. 2-60.
From this panel, the “Run” button can be pressed to initiate the predictions.
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Figure 2-61: Planning Grid Setup Panel

An example of the high-altitude sector count prediction displays for the Fort Worth
ARTCC are shown in Figs. 2-62 through 2-64.  In Fig. 2-62, the sector counts are
represented in a grid display in which the columns represent data for the various selected
sectors and the rows represent the time intervals.  The row labeled “Cap” refers to the
capacity or the Monitor Alert Parameter (MAP) of the various sectors.  The results in Fig.
2-62 are representative of a two hour prediction that started at 0:00 UTC.  The numbers
in each of the green/yellow cells is the instantaneous maximum number of aircraft
occupying one of the sectors during any of the displayed time intervals.  The green color
coding indicates that the sector is below the MAP value, while the yellow color coding
indicates that the MAP was exceeded as a result of proposed departures.  Red color
coding, which is not shown in this figure, indicates that the MAP value was exceeded as a
result of actively flying aircraft.  Selecting any of the cells will generate an alternative
display that lists the aircraft predicted in each of the time intervals.
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Figure 2-62: Planning Sector Grid Display

A second display that can be used to visualize the FACET sector count predictions is
shown in Fig. 2-63.  In this display mode, the counts for each sector are displayed on a
separate tab.  Toggling between the various tabs is accomplished by selecting the name of
the sector at the top of the display.  For a given sector, the time in 15 minute increments
is displayed on the horizontal axis and the sector counts are displayed on the vertical axis.
The red color coding in this case is used to represent active flights and the yellow color
coding is used to represent proposed flights.  The dark horizontal line at 17 is used to
represent the capacity or MAP level for this sector (ZFW86 in Fig. 2-63).  Clicking on
any of the vertical bars in this plot will produce a list of flights that are predicted to
occupy the sector during the selected time interval.

Figure 2-63: Planning Bar Graph Display

The final display used to represent the sector counts in depicted in Fig. 2-64.  The left
image in this figure allows the geographical location of congested sectors to be quickly
identified.  The scroll bar at the bottom of this figure allows the congestion at the various
prediction time intervals to be visualized.  As in the discussion regarding Fig. 2-62, if a
sector is predicted to exceed the MAP value as a result of actively flying aircraft then the
sector will be highlighted red.  Clicking on any of the sectors in the left image in this
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figure will lead to a display similar to the right image in this figure.  The right figure
contains a tab for each of the aircraft that are predicted to enter the selected sector.  The
current position of the aircraft is displayed along with the flight plan route, great circle
route, the wind optimal route, and a waypoint-snapped wind optimal route. The last two
require that a wind data file was read in.  Any congested sectors that the aircraft is
predicted to encounter  is also displayed in this panel.  In the bottom portion of this
display, the ETA, total distance to destination, fuel burn estimate, and flight plan are also
presented. Clicking on any sector provides further information about the flight.

Figure 2-64: Planning Map Display

2.5.8 Query Server

By selecting the QueryServer menu item from the Applications menu, the “Query
Server” panel that is shown in Fig. 2-65 can be accessed.  This panel is used to monitor
the total number of queries received, the number of active query connections, and the
number of active ports supporting queries.  Additional details regarding this panel can be
obtained by directly contacting the FACET development team lead.
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Figure 2-65: Query Server Panel

2.5.9 Sim/Pred Stats

By selecting the Sim/Pred Stats menu item from the Applications menu, the
“Simulation/Prediction Statistics” panel that is shown in Fig. 2-66 is displayed.  This
panel is largely used for software testing and debugging purposes in order to assess the
reliability of live ETA predictions.  Under normal operating conditions, the end FACET
user will not need to access this panel.
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Figure 2-66: Simulation/Prediction Statistics Panel

2.5.10 NAS Constraints

By selecting the NAS Constraints menu item from the Applications menu, the “NAS
Constraints” panel that is shown in Fig. 2-67 is displayed.  This panel can be used to
setup reroutes (either playbook or CDRs), metering restrictions and departure controls.
These constraints can only be invoked in simulation or planning mode.  A description of
the various setup parameters on this display follows:

o Restriction Tabs: Individual tabs for invoking Playbook routes, CDRs, miles-in-
trail restrictions, departure control restrictions, and delay statistics are available.
Additional details regarding each of these tabs follows.

o Buttons: The various buttons on the main panel are used for displaying routes,
invoking restrictions, and canceling restrictions.  Menu buttons are disabled if
they are not applicable to the currently displayed restriction tab.

o Display Graphics: Used to display one of the selected playbook routes.
o Cancel Display: Used to cancel the display of one of the playbook routes

that was previously displayed.
o Clear All:  Clear all graphics for routes being displayed (playbook or

CDR).
o Display Text: Display the text associated with a playbook route.
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o Implement: Used for implementing a reroute, departure, or metering
restriction

o Cancel: Used to cancel a restriction that was previously implemented. The
user must first select the restriction from the "Implemented Plans" list
before canceling it.

o Close: Allows the "NAS Constraints" panel to be closed.
o Menus

o File: Used when loading or saving metering or departure control
constraints.

o Prefs: Used to change the color of CDR routes that will be displayed.
o Display: Allows auxiliary displays to be brought up for monitoring

rerouted aircraft or for examining delay statistics.
o Setup: Used to setup Sectors for monitoring during batch processing.
o Help: Displays the on-line help documentation for this panel.

The “Playbook Setup” panel that is shown in Fig. 2-67 contains a list of all playbook
routes currently implemented in FACET.  These routes have been extracted from the html
documentation maintained at the ATCSCC website (www.fly.faa.gov).  After a playbook
route has been selected, it can be displayed or implemented. Implementing a play will
cause all appropriate aircraft to be rerouted when either a simulation is run or the
planning functionality is used.  To cancel the rerouting specified by a Playbook plan, the
user should first select the plan then press the "Cancel" button.

Figure 2-67: NAS Constraint Playbook Setup Panel
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The “CDR Selection”  panel that is shown in Fig. 2-68 contains all of the Coded
Departure Routes available within FACET. The database containing these routes is
electronically available at the ATCSCC website (www.fly.faa.gov).  After a route has
been selected, it can be displayed or implemented. Implementing a route will cause all
appropriate aircraft to be rerouted when either a simulation is run or the planning
functionality is used.  To cancel the rerouting specified by a CDR, the user should first
select the route then press the "Cancel" button.
Routes can be displayed in one of two ways. Either the user can select one of the routes
from the list or specify part of the "route code" in the "Route Code" field. Examples of
acceptable route codes are "JFKORD" and "ORDEWR0E".  The color of a route can be
modified by first selecting a new color from the Prefs->Route Color menu then selecting
the desired routes

Figure 2-68: NAS Constraint CDR Setup Panel

Using the “Metering” setup panel that is shown in Fig. 2-69, a distance based miles-in-
trail restriction can be implemented in either FACET’s simulation or planning modes.
Using the limited fields in this panel, a flow can be defined as a stream of aircraft
crossing either a fixed point in space or a line.  The "Fix/Name" field is used in one of
two different ways. When metering is applied at a fix, then this field is used to specify the
fix name. When metering is applied at a boundary, then this field used to "label" the
metering constraint. This label is used internally in FACET to identify the specified
constraint.  The "Mile-In-Trail" field is used to specify the MIT restriction in nautical
miles, which is to be imposed at the specified fix/boundary.  The "Route Through Fix"
field is used to specify a downstream fix through, which the metered aircraft are going to
pass. This allows the user to specify the direction of the flow of aircraft. If the "meter fix"
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and the "route fix" are the same, then all aircraft crossing the fix will be metered
regardless of their direction.  The "Start Time" and "Stop Time" fields are used to specify
the start and stop of the metering restriction. The times specified in these fields should be
of the following format: HHMM. For example, "1300" is the acceptable way to specify
13:00 UTC.  The "Control Speeds" option enables the speeds of the impacted aircraft to
be controlled after the aircraft passes the metering fix/bndry. If the speeds are not
controlled, then the aircraft will resume the nominal air speed after passing the meter
fix/boundary.
It is important to note that the underlying algorithms used by the “metering” algorithm
have not been operationally validated and are still under development.  For the current
status of the MIT algorithms, the interested user is encouraged to contact the FACET
development team lead.

Figure 2-69: NAS Constraint Metering Setup Panel

The “GDP Setup” panel that is shown in Fig. 2-70 can be used to define arrival
restrictions, departure restrictions, and ground stops.  Within the context of this
application, an “arrival restriction” is a restriction that controls arrival rates to meet a
constraint at a destination airport.  This control action best approximates a ground delay
program in FACET.  A “departure restriction” within the context of this application is a
restriction in which the departure rate at an airport is reduced as a result of an airport
constraint or an en route constraint.  This restriction, in some respects, restricts the flow
of departures much like the departure spacing program (DSP).  A description of the
available setup parameters follows:

o “GDP/GSP Setup”: Entries are used to define the basic restriction
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o Type: Used to select between an arrival restriction, a departure restriction,
or a ground stop.

o Airport: Specifies the constrained airport
o AAR: Sets the airport arrival/departure rate
o Start Time: Used to set the restriction start time
o Stop Time: Used to set the restriction stop time
o Mode: Interactive or Batch (batch can only be used offline in planning

mode)
o “Filter Entries”: Used to specify which aircraft are included/excluded from the

restriction
o Apply All: Impacts all flights
o Apply To: Impacts only flights from selected airports, centers, or tiers
o Apply Radius: Impacts only flights within X nm of the impacted airport
o Exclude: Excludes aircraft from the restriction from the specified airports,

centers, or tiers

Figure 2-70: NAS Constraint Departure Control Setup

After implementing any of the available “NAS Constraints”, the aggregate impact of the
constraints in terms of the delays can be explored using the “Delay Stats” panel that is
shown in Fig. 2-71.  For each implemented restriction, the following information is
displayed:

o Name of the TFM initiative.
o Number of aircraft impacted.
o Total delay for this initiative in minutes.
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o Average per aircraft delay associated with this initiative (min.)
o The total (summed) impact of all implemented TFM constraints are also

presented. The "Diffs" field, reports differences in delay statistics as compared to
a previous set of saved results.

This panel also has a number of unique buttons associated with it that allow the user to
save delay statistics for comparison purposes.  A description of each of these follows:

o "Save" button allows the current delay stats to be stored in RAM.
o "Show Current" shows the current delay statistics.
o "Set Baseline" sets the calculations to be used in the "diff" calculations
o "Remove Saved" remove delay stats that have been saved.

Figure 2-71: NAS Constraint Delay Stats Panel

2.5.11 MIT Monitor

By selecting the MIT Monitor menu item from the Applications menu, the “MIT
Monitor” panel that is shown in Fig. 2-72 is displayed.  The original intent of this
application was to allow a user to define, monitor, and analyze a MIT impacted traffic
streams in post-operations.  To some extent, the application was largely tailored to
examine restrictions from congested northeast airports, such as EWR.  This application
was only tested under very limited scenarios and is currently unstable.  Any user
interested in utilizing this functionality is advised to contact the FACET development
team lead for a list of potential alternative applications.
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Figure 2-72: MIT Monitor Panel

2.5.12 FCA Monitor

The “FCA Monitor” panels that are shown in Fig. 2-73 can be accessed by selecting the
FCA Monitor menu item from the Applications menu.  From these panels, a user can
define a region in which to monitor the flow of traffic and initiate the monitoring process.
Regions can be either user defined FCAs or CCFP weather areas.
Selecting the “Monitor List” tab reveals the first of the three panels shown in Fig. 2-73.
The white rectangular area on this panel is used to maintain the list of currently
monitored regions.  A list of flights utilizing any of these regions can be obtained by
pressing the “Display List” button.  Monitored regions can be removed from the list by
first selecting the region name from the list of available regions then pressing the
“Remove Item” button.
The second panel shown in Fig. 2-73 is used to create or import FCAs that can be
monitored.  A description of each of the parameters on this panel follows:

o “New”: Used to initiate the creation of a new FCA.  This process is described in
more detail below.

o “Edit”: Used to edit an existing FCA.  First select the FCA name from the list of
available FCAs the press the “Edit” button, and follow the on-screen instructions.

o “Remove”: After selecting the FCA name from the list of available FCAs, press
this button to remove the region from FACET.

o “Show Name”: Selecting the check box enables the display of the FCA name on
the FACET display.

o “Add to Monitor List”: After selecting the FCA name from the list of available
FCAs, press this button to add the FCA to the list of currently monitored FCAs

o “Load”: Used to load an FCA definition into FACET from a previously created
file.

o “Save”: Used to save an  FCA to a file
After creating or importing the FCAs of interest and adding the FCAs to monitor to the
appropriate list, this dialog box can be closed.
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Figure 2-73: FCA Monitor Panel

Creating a new FCA in FACET can be accomplished with the easy-to-use and intuitive
display that is shown in Fig. 2-74.  The various parameters on this display are as follows:

o “Name”: Name of the FCA.  If a name is not specified, FACET will generate a
default name.

o “Altitude Minimum”: Specifies the minimum altitude of the FCA in feet
o “Altitude Maximum”: Specifies the maximum altitude of the FCA in feet
o “Speed”: Optional parameter that can be used to define the speed of a moving

FCA
o “Heading”: Optional heading of the FCA, which is only useful if a non-zero speed

has been defined
o “Time”: Specifies the time that the FCA will become active
o “Add”: Pressing this button will add a new node to the existing FCA
o “Edit”: Pressing this button can be used to edit an existing FCA latitude/longitude

pair
o “Delete”: Pressing this button allows a FCA node to be deleted
o “Close Polygon”: Closes the polygon defining the FCA
o “Undo All”: Removes all previously defined FCA latitude/longitude points
o “Done”: Pressing this button will add the currently defined FCA to the list of

available FCAs
Selecting points from the main FACET display with the mouse creates the horizontal
boundary of the FCA.  The selected latitude and longitude points appear in the list area
provided on this panel.
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Figure 2-74: Create FCA Panel

The third panel shown in Fig. 2-73 is used to add CCFP areas to the list of monitored
regions.  If a CCFP file has been previously read into FACET, the list of available CCFP
areas will be displayed on this panel.  A description of the various parameters available
on this panel are as follows:

o “Add to list”: After selecting one of the available CCFP areas a user presses this
button to add it to the list of monitored regions.

o “View CCFP data”: Displays the CCFP panel that was discussed in Section
2.3.8.6.

o “Auto-monitor”: Selecting this button will allow FACET to automatically monitor
flights that enter newly defined CCFP regions

2.5.13 FCA Avoidance

The “FCA Avoidance” panels that are shown in Fig. 2-75 can be accessed by selecting
the FCA Avoidance menu item from the Applications menu.  The first panel in this
figure is used to initiate the cell avoidance algorithms, while the second panel is strictly
used to define sectors that are to be avoided.  A description of each of these panels
follows.
The various parameters in the left panel of Fig. 2-75 are defined below:

 “Cell Type”: Used to define the types of cells to route around.  Available choices
are FCAs, Sectors, and CAPE weather cells.  If Sectors is selected, then the right panel in
Fig. 2-75 is used to define the sectors to route around.

 “Cell Intensity”: When routing around CAPE weather cells (see 2.3.8.4), this list
is used to define the minimum CAPE intensity to avoid

 “Current Time”: Specifies the current simulation time
 “Start Rerouting”: Specifies when rerouting should start
 “Stop Rerouting”: Specifies when rerouting should end
 “Accept”: Pressing this button initiates the rerouting process
 “Quit”: Cancels the rerouting process
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Aircraft that are being rerouted will be color coded blue on the FACET display.  In
addition if the flight plan for a rerouted aircraft is displayed, a user will see both the
nominal and rerouted flight plans.
The right panel in Fig. 2-75 is only used when a user wishes to route aircraft around a
sector.  From this panel, the sector to avoid, the center this sector resides in, and the color
that is used to highlight the sector to avoid is specified.  After selecting  a sector to avoid
from the main display, press the “Add” button to add it to the list of avoided sectors.
Pressing the “Remove” button is used to remove a sector that was previously being
rerouted around.  The “Clear All” button is used to remove all sectors from the list of
sectors to avoid. The ‘Affected Ac’ under the Display menu shows a list of affected
aircraft with their flight plans. The Calculations menu has options for selecting the
following: Max Ac: Maximum number of permitted aircraft through the selected region,
and Look-ahead time: How early to initiate the rerouting for an aircraft.
It also has the option of selecting one of the two rerouting algorithms and using newly
created routes using lat/long points or waypoints database.

Figure 2-75: FCA Avoidance Panels

2.5.14 Fly-by Animation

By selecting the Fly-By Animation menu item from the Applications menu the “Fly-By
Animation” application that is shown in Fig. 2-76 can be accessed.  This application can
only be used with a live FACET run. Fly-By Animation (FBA) assembles aircraft and
weather data from other parts of FACET, allowing a more comprehensive view of past
and future conditions than is possible in the main FACET window. It stores aircraft data
at fixed intervals over a range of times, any of which can be selected and displayed using
the slider at the bottom of the window. This aircraft data is divided into two sets: past and
future. The time stamp of the latest aircraft data in the set of past aircraft will be referred
to as the last update time, and the slider tick representing this time is indicated by a
rectangle above its label. The last update time always appears at the same position on the
slider. Each slider tick corresponds to one snapshot of aircraft data, and the difference in
time between successive ticks will be referred to as the update interval. Closing the FBA
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window stops it from continuously updating its aircraft data, but does not affect the
aircraft already stored.
FBA is designed to work with streaming CIWS weather data. A CIWS stream carries
periodic updates, each of which consists of "products" covering from one hour into the
past to two hours into the future. Accordingly, FBA stores and can display aircraft data
for the same period: one hour in the past to two hours in the future, as indicated by the
range of the slider at the bottom of the window.
Each CIWS product is meant to represent the weather at only one instant, but FBA treats
each product as if it applies over a range of times, according to the following table. In the
table, times are in minutes relative to the current time, and the notation "[x,y)" represents
the range from x to y, including x but not including y.
FBA receives aircraft data in three ways:

From the aircraft list:
When continuous updating is enabled (see "Menus" below) and the time from the
last update time to FACET's current plot time is at least as large as the update
interval (see definitions above), the following actions are performed:
The past aircraft data is repeatedly shifted backwards until the new plot time is
earlier than one update interval past the last update time. Each time the data is
shifted, the earliest data is discarded, and last update time increases by one update
interval.
The future aircraft data is shifted by the same amount as the past data.
The latest position in the set of past aircraft data (corresponding to last update
time) is filled with the aircraft found in FACET's aircraft list.

From aircraft histories:
When requested (see "Menus") or when FBA starts up, data is read from the
historical data stored by each aircraft in FACET's aircraft list. Before reading
from histories, if the last update time is out of date compared to FACET's plot
time, then the aircraft data is shifted as described above. After that, each snapshot
in the past that contains no aircraft is filled with historical data.

From predictions:
When continuous updating is enabled, FBA receives aircraft data from any
running prediction. These aircraft are stored as future data. As with the two
methods above, stored aircraft will first be shifted as necessary before being
updated with the predicted data.
Each slider tick representing a time for which FBA has aircraft data will be
labeled with a color corresponding to how that data was obtained.

The menus available from the FBA display are defined as follows:
o Aircraft:

o Continuously update: While enabled, FBA watches the current plot time
and updates itself when necessary (see "Aircraft Data" above). This setting
also determines whether predicted data is received. Stopping a FACET run
or closing the FBA window will disable this setting.

o Load from histories: Causes aircraft data to be loaded from histories (as
described above).

o Clear all aircraft: Clears all aircraft data and initializes the last update
time.

o Weather:
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o Read CIWS streaming data: Initiates reading of CIWS streaming data.
FBA does not store its own copy of weather data, so this menu item has
precisely the same effect as the similarly-named menu item in FACET's
Weather dialog.

o Enforce CIWS times: When enabled, weather will only be displayed in
FBA if the last update time falls within the valid range for the current
CIWS data.

o Display:
o Show legend: Each slider tick with corresponding aircraft data is labeled

with a colored rectangle according to how that aircraft data was received.
This menu item displays a legend showing which colors are used for
which methods of received aircraft.

o Navigate: Items in this menu change what is shown in the display.
o Animation:

o Play/Pause: Equivalent to pressing the Play/Pause button next to the slider.
When playing, the slider position cycles through all of its possible
positions in order.

o Forward one frame: Moves the slider position forward to the next tick or,
if it has reached the end, back to the first tick.

o Back one frame: Moves the slider position back to the previous tick or, if
it has reached the beginning, to the last tick.

o Set playback frame delay: Opens a dialog to specify the delay to wait
between frames when playing.
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Figure 2-76: Fly-by Animation Display

2.5.15 Conflict Detection

The Conflict Detection panel that is shown in Fig. 2-77 can be used to detect aircraft
conflicts when FACET is run in simulation mode.  This application is useful, for
example, when identifying potential conflict between aircraft while flying on great circle
or wind optimal routes.  Selecting the Conflict Detection menu item from the
Application menu can access this application.

A description of the various parameters on the panel follows:

o  Center: Use this to select the Center in which the calculations should be
performed. If USA is selected, the calculation will be carried out over the entire
US. This is compute intensive and should be used with caution.

o Surveillance Zone: Specifies the zone around each aircraft in which to search for
conflicts.  For example, if surveillance zone is set to 120 nm then each aircraft is
compared with all other aircraft within a 120 nm radius circle for potential
conflicts.

o Look-Ahead Time: Temporal duration of the trajectory that is generated for each
aircraft for conflict detection purposes.

o Horizontal Separation: Minimum horizontal separation requirements in nm
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o Vert Sep. Below FL290: Vertical separation limits below FL290 (i.e. 29,000 feet).

o  Vert Sep. Above FL290: Vertical separation limits above FL290 (i.e. > 29,000
feet).

o Output File: Used to select an output file in which conflict data is written.

o  Display Conflicts: If this box is selected then the aircrafts in conflict will be
graphically highlighted on the main FACET canvas.  Highlighting typically
entails changing the aircraft symbol color to red and displaying the flight plan
data block.

o Output File: If an output file was selected from the File menu then the output file
name will appear here.

o  Enable: This button will initiate the conflict detection calculations. Once a
simulation or data playback begins, the CD algorithm will begin looking for
conflicts. If the user requested that the data be written to an output file then this
will also begin.

o  Disable: This button will terminate a previously initiated conflict detection
session.

o  Plot: This button is used to display a window in which the conflict count as a
function of time is displayed.

o Close: Close the conflict detection setup panel
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Figure 2-77: Conflict Detection Setup Panel

2.5.16 Conflict Detection and Resolution

The Conflict Detection and Resolution (CD&R) application in FACET can be invoked
from the panel shown in Fig. 2-78.  This panel can be accessed by selecting the Conflict
Detection and Resolution menu item from the Applications menu.  By default, this
application is disabled, but both a “Geometric Optimization” algorithm and a “Potential
Field Method” algorithm are available.  Numerous journal articles have been written that
describe both of these algorithms.  For additional algorithmic documentation, the
interested user should contact the FACET software development lead.

o  Selecting the “Geometric Optimization Method” radio button invokes the
Geometric Optimization CD&R algorithm.  A description of the various
parameters available for this model follows:

o  Resolution Type: Conflicts within FACET can be resolved by one of four
different approaches: (1) Best Heading + Speed Change, (2) Heading Change, (3)
Speed Change, and (4) Vertical Speed Change.  Selecting the radio button
adjacent to one of these control strategies invokes the selected strategy.

o  Write file: Data generated by the CD&R algorithm can be written to a file by
selecting this check box and specifying the output file name

o  Surveillance Zone Radius: Radius in which each aircraft searchers for potential
conflicts to resolve

o Look-ahead time: Duration of the trajectory that is generated for each aircraft



FACET User Guide –
4/10/06

73

o  Horizontal separation standard: Minimum acceptable horizontal separation
between any two aircraft.  Separation below this threshold will result in a
resolution action.

o  Vertical separation standard: Minimum vertical separation between any two
aircraft.  Separation below this threshold will result in a resolution strategy.

o Apply: Used to apply the aforementioned CD&R parameters to the current run

The second algorithm available for resolving conflicts in FACET is the “Modified
Potential Field” algorithm.  This algorithm only works in two dimensions, so control
strategies such as altitude changes are not permitted.  Selecting the “Modified Potential
Field Method” radio button invokes this algorithm.  No additional setup parameters are
required, as it uses the default parameters used for the Geometric Optimization method

The second panel available on the CD&R Setup panel is the “Statistics” panel.  This
panel simply displays the total number of aircraft currently in the system and the number
of aircraft that have been impacted by one of the implemented CD&R algorithms.
Aircraft under control of one of these algorithms will be colored red on the FACET
display.  After the resolution strategy has completed the aircraft color will resort to the
system default color.

Figure 2-78: Conflict Detection and Resolution Panel

2.5.17 Direct To

The Direct To (D2) routing application in FACET can be invoked from the panel
shown in Fig. 2-79.  This panel can be accessed by selecting the Direct To menu
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item from the Applications menu.  The basic premise behind the direct routing
algorithms is to identify wind favorable “short cuts” along an aircraft’s route of
flight within a limited area (e.g. a center or a boundary rectangle).  Within
FACET, aircraft can be placed on direct-to routes using one of the following
methods: (1) NAS Model, (2) ARTCC Model, and (3) CTAS Generated Routes.
Using the “Setup” panel that is shown in the left most image in Fig. 2-79, a user
can select between these three different methods.  A brief discussion regarding
each of these routing options follows.

NAS Model:

The algorithm responsible for the direct routing is based on the CTAS D2
algorithm. When generating direct routes, this algorithm does not search for
conflicts and does not prohibit routing through SUAs. Using this algorithm, a
piece-wise continuous route is generated by constructing "direct routing"
segments through each ARTCC that the flight plan passes through. If less than
one minute of savings is recorded in any of the ARTCC's, then the leg of flight
through that ARTCC follows the original flight plan.

Summaries of the direct routing algorithm are displayed on the "Summary" and
"Results" tab. From the "Results" tab, the user can select a particular aircraft,
which is being rerouted and display both the original and modified flight plan.
The delay statistics can be displayed on either a pie chart or a bar chart by
bringing up one of the auxiliary displays in the Display menu item.

The statistics generated from the "NAS Model" can be saved to a file by selecting
the Save Direct-To Stats menu item from the File menu.

Figure 2-79: Direct-To Panels

ARTCC Model:

 Selecting the "ARTCC Model" option will display the setup panel in Fig. 2-80.
The ARTCC model algorithm is based on the CTAS D2 algorithm and direct-to
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routing is confined to a user specified ARTCC.  For example, if a SFO departure
passes through ZFW en route to MIA, the direct-to routing algorithm will only
look for “short cuts” in ZFW if this is the user selected center.  When generating
direct routes, this algorithm does not search for conflicts and does not prohibit
routing through SUA's.

The various inputs for this algorithm are as follows:

o "Select a Center" - Allows selection of the ARTCC for the analysis.

o  "Calculation Type" - Select either "Conflict Statistics" or "Time Savings."
"Conflict Stats" will record the positions and times for all conflicts
occurring when the D2 algorithm is activated. "Time Savings" will record
the acid and time savings for each aircraft, which is a direct routing
candidate.

o "Altitude Choice" - Implements a filter to select only a subset of aircraft for
direct routing. For example, if "Low" is selected, then only aircraft in the
low altitude Sectors (roughly FL240 and below) will be rerouted.

o "Set Bounding Box" - Allows the user to define a bounding box around the
selected ARTCC. This box will be used when determining the last
waypoint that the aircraft is able to fly direct to.

o  "Select an Output File" - Selecting this option will display a dialog box
from, which a file can be selected for logging the D2 results.

o "Show Bounding Box" - Allow the D2 bounding box to be displayed.

Please note that the "Summary" and "Results" panel will only show statistics for
the NAS D2 algorithm. Similarly, the File and Display menu items should only be
used with the NAS D2 algorithm.
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Figure 2-80: D2 ARTCC Model Setup Panel

CTAS D2 Analysis:

When "CTAS D2 Analysis" is selected, the user will be presented with a dialog
box from which they can specify a file containing D2 candidate aircraft for
analysis. It is assumed that this file was written from the CTAS D2 GUI. A
sample of the input file can be viewed here: sample file (???).

This application is most useful when run in conjunction with planning with live
data. When the application is run in this fashion, then the flight plan for each
aircraft in the input file will be examined and a list of Sectors through which the
aircraft is going to pass through will be written to a file called "d2-facet.preds".
Each of the sectors the aircraft would pass through will be compared against the
latest set of predictions. The congestion status of each of the Sectors will also be
written to the output file.

2.5.18 RLV Analysis

The “RLV Analysis” application in FACET can be invoked from the panel shown
in Fig. 2-81.  This panel can be accessed by selecting the RLV menu item from the
Applications menu.  From this panel, the user can either create a landing or
launch corridor, which can be used to study the impact of an RLV on NAS traffic.
After setting up this panel, the user will need to run FACET either in playback or
simulation mode in order to collect the required data. The launch/landing
windows are generated based on performance data from the X-33.  The
description of the setup parameters associated with this application follows:
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o Landing/Launch Site: Select between Kennedy Space Center, Vandenberg
AFB, Edwards AFB, or JFK

o SUA Type: Specify whether a "SUA" should be created to define an RLV
launch or landing site.

o SUA Orientation: Specify the orientation of the landing/launch corridor.

o Max SUA Altitude: This is to be used to specify the upper bounds on the
altitude of the SUA for monitoring purposes.

o SUA Width: Specify the width in nm of the landing/launch corridor.

o  SUA Length: Based on the "MAx Altitude", FACET will determine the
SUA length from the performance models for the X-33.

o  Select Output File: Use this option if an output file is desired. Since no
other output is available from this application, it is highly desirable to
record the output data to a file.

o  Display SUA: Flag to graphically display the SUA created for the
landing/launch corridor. By default, no graphics appear on the screen.

o Start: Creates the SUA within FACET. Once a simulation or data playback
begins, output will be written to the specified file if appropriate.

o Stop: Stop the calculations.

o Close: Close this panel
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Figure 2-81: RLV Analysis Setup Panel

2.5.19 Capture Images

The “Capture Images” application in FACET can be invoked from the panel shown in
Fig. 2-82.  This panel can be accessed by selecting the Capture Images menu item from
the Applications menu.  This simple application uses the popular xwd screen capture
utility that is available on most unix/linux systems to capture a sequence of images of a
user selected window.  The setup parameters associated with this application are as
follows:

o Image File Prefix: Prefix of the image file name

o Window ID: ID of the window that is to be capture.  A utility such as xwininfo
can be used to determine this id.

o Image Cnt: Counter to determine how many images have been captured

o Start: Used to start the image capture process

o Stop: Used to stop the image capture process

o  Reset Counter: Resets the “Image Cnt” and the image count suffix that is
appended to each image file name

o Close: Closes the Capture Images display
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Figure 2-82: Capture Images Setup Panel

2.5.20 Scripts

By selecting the Scripts menu item from the Applications menu the “Scripts” application
that is shown in Fig. 2-83 can be accessed.  This application can be used to automate
sequences of key presses within FACET.  For additional information about this
application, the interested reader is referred to the “Help” documentation accompanying
this panel.

Figure 2-83: Scripts Setup Panel

2.5.21 Internet

The Internet menu item appearing in the Application menu was originally designed to
allow a user to access select TFM related websites directly from FACET.  This
appl icat ion is  current ly  under  construct ion.  However ,  typing
http://www.fly.faa.gov/flyfaa/images/pacing.gif in weather textfield provides the latest
pacing airports information image in a new window.
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3 System Usage

This section is designed to provide step-by-step instructions for performing some of the
more common FACET procedures.  The list of currently documented procedures and
their corresponding section numbers follow:

3.1: Starting FACET

3.2: Replaying Historical Data

3.3: Pause/Restart/Resume/Terminate

3.4: Applying Aircraft Filters

3.5: Plotting Center Counts

3.6: Predicting Sector Counts

3.1 Starting FACET

The steps for starting FACET are as follows:

Step 1: Open a terminal window

Step 2: cd $FACET_HOME/init

Step 3: ./run

The latter two steps are typed at the command prompt in the terminal window.
$FACET_HOME refers to the full path name of the directory in which you have installed
FACET.  After executing the “./run” script, it typically takes several minutes before main
FACET window is displayed.

For convenience, a user may wish to add alias, such as

alias cdFACET    “cd /home/facet_user/facet/init”

alias runFACET   “cdFACET; ./run”

to either the .aliases, .cshrc, or .tcshrc file in the user’s home directory.

3.2 Replaying Historical Data

After starting FACET using the procedures outlined in Section 3.1, historical data can be
played back through FACET using the steps outlined in this section.  Running FACET in
this particular mode is useful, for example, when attempting to explore an air traffic
scenario in post operations.
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STEPS DESCRIPTION

STEP 1:

Choose Select New Run
from the Simulation menu.

STEP2:

Select the Playback radio
button from the “Set Up
New Run” panel.

STEP 3:

Set the playback run
attributes (e.g. synchronous
or asynchronous, trajectory
update interval, etc.) and
select the “Browse” button.
By default, none of the
attributes should require
changing.
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STEP 4:

Select the playback input file
and press the Open button.
The file format filters can be
used to choose between
ASDI_, TRX_, and HOST_
input files.

STEP 5:

Press the Start button to
initiate the FACET playback
session.

STEP 6:

Aircraft tracks should begin
appearing on the main
FACET display.  The name
of the input file, current
aircraft count, date, and time
will also appear on the
display.  The “(pbk)” suffix
appended to the file name
indicates that FACET is
replaying historical data.

3.3 Pause/Restart/Resume/Terminate

This section discusses how to pause, restart, resume, and terminate either a FACET
simulation or playback session.  Capabilities for pausing, resuming, and terminating exist
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both on the FACET toolbar, as well as, in the Animation menu.  This section will
primarily discuss the capabilities available on the toolbar, but the user should also be
aware of the menu-based options.

The following steps assume that a FACET playback or simulation session are already in
progress.

STEPS DESCRIPTION

STEP 1:

Press the Pause Icon (two
vertical lines) to pause the
simulation.  Alternatively,
the Animation-
>Pause/Resume menu item
can be selected.

STEP 2:

After selecting the pause
button, the icon changes to a
right pointing rectangle,
which is used to designate
the Resume button.  Notice
also the Status field is now
set to “Paused”.

STEP 3:

Resuming the session can be
accomplished by selecting
the “Resume” icon (right-
facing triangle), or by
selecting the Animation-
>Pause/Resume menu item.

STEP 4:

Terminating or stopping a
simulation or playback
session is accomplished by
selecting the stop-sign icon.
Notice that the status
becomes “Stopped” after
selecting this icon.
Alternatively, the
Animation->Terminate menu
item can be selected.
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STEP 5:

Restarting a previously
terminated session can be
accomplished by selecting
the Animation->Restart
menu item.

3.4 Applying Aircraft Filters

After a FACET session has been initiated in any of the available runtime modes (i.e..
playback, simulation, hybrid, or live), the filtering capabilities are useful for highlighting
particular streams or flow of aircraft.  As an example of how to utilize the filtering
capabilities, a scenario in which all aircraft departing ORD for ATL will be explored.
The following steps assume that a FACET session is already in progress.

STEPS DESCRIPTION

STEP 1:

Select the Aircraft->Filter
menu item.
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STEP 2:

In the Filter panel, enter
ORD as the origin airport,
and ATL as the destination
airport.  Also, select the
“Show History” check box,
deselect the “Show Data
Tag” check box, and select
the “Display Filtered
Aircraft Only” checkbox.

STEP 3:

Pressing the “Add Filter”
button results in the filter
definition being added to the
list of “Applied Filters”.

STEP 4:

The FACET display will be
automatically be updated to
show only the flights
departing ORD en route to
ATL.
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3.5 Plotting Center Counts

After a FACET session has been initiated in any of the available runtime modes (i.e..
playback, simulation, hybrid, or live), the “Plot Data” application can be used for
calculating sector counts, center counts, and individual aircraft statistics among other
items.  As an example of the utility of this application, the Center counts in ZAU, ZNY,
and ZTL will be plotted as a function of time.  The following steps assume that a FACET
session is already underway.

STEPS DESCRIPTION

STEP 1:

Select the Applications-
>Plot Data menu item.

STEP 2:

Select the “Aircraft in
center/sector” radio button
and enter “ZAU,ZNY,ZTL”
in the available text field.
Alternatively, center/sector
names can be graphically
selected by pressing the
“Choose” button.
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STEP 3:

Press the “Add to new
window” button.  The list of
“Current Plots” will be
updated with the latest plot
request, and a blank plot
window will be displayed.

STEP 4:

The aircraft counts in the
Plot Window will
dynamically update as
FACET processes the input
data stream.

3.6 Predicting Sector Counts

The FACET “Planning” capabilities can be used for predicting sector counts, fix crossing
counts, airport arrival/departure rates, FCA counts, among other things.  Predictions can
be performed using either historical data in the TRX_ format or live ASDI/ETMS data.
The following scenario illustrates how a two hour sector count prediction can be
performed for all of the high-altitude sectors in ZFW using a prerecorded TRX_ data file.

STEPS DESCRIPTION
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STEP 1:

Select the Applications-
>Planning menu item.

STEP 2:

Press the “Input File” button
to display the file selection
dialog box.

STEP 3:

Highlight the desired TRX_
file and press the “Open”
button.
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STEP 4:

Press the “New Grid” button
on the Planning Setup
display.

STEP 5:

Select the “High Altitude
Sectors” folder from the
“Fort Worth” folder, press
the “Add” button, then press
the “Run” button.

STEP 6:

After FACET has completed
the requested predictions, the
sector grid display will be
populated with non-zero
entries.

STEP 7:

Selecting any of the grid
cells with the mouse button
will result in a list of the
aircraft that are predicted to
occupy the selected sector
during the specified time
interval.
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STEP 8:

To view the sector counts in
a bar graph format, select the
Table->Show Graph menu
item from the Sector Count
display

STEP 9:

The sector name tabs can be
selected to display the
active/proposed sector
counts for each of the
selected sectors.

STEP 10:

To view the sector alerts in a
map display format, select
the Table->Show Map menu
item from the Sector Count
display

STEP 11:

Different time intervals can
be displayed on the Map
Display by moving the
scrollbar at the bottom of the
display panel.  The current
prediction interval is shown
at the top-left of the display.

Selecting any of the sectors
displays a list of aircraft
predicted to enter the sector
during the specified time
interval.
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STEP 12:

A graphical depiction of
each aircraft predicted to
enter the selected in the
selected sector is displayed.

The aircraft tabs can be
selected to toggle between
the various aircraft displays.
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4 ACRONYMS

ATM Air Traffic Management

ARTCC Air Route Traffic Control Center

ASDI Aircraft Situation Display to Industry

CAPE Convective Available Potential Energy

CCFP Collaborative Convective Forecast Product

CD Conflict Detection

CDR Coded Departure Route

CD&R Conflict Detection and Resolution

CIN Convective Icing N???

CIWS Corridor Integrated Weather System

CTAS Center-TRACON Automation System

D2 Direct-To

EDR ETMS Data Reader

ETMS Enhanced Traffic Management System

FACET Future ATM Concepts Evaluation Tool

FCA Flow Constrained Area

GFS Global Forecast System

NAS National Airspace System

NCWF National Convective Weather Forecast

NFDC National Flight Data Center

NOTAM NOTice to AirMen

PWAT Precipitable Water
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RLV Reusable Launch Vehicle

RUC Rapid Update Cycle

SSRUN Storm Surface RUNoff

SUA Special Use Airspace

TFM Traffic Flow Management

TSD Traffic Situation Display

Appendix A: Synchronous and Asynchronous Modes of Operation

Modes and Operational States

FACET can operate in either simulation mode or playback mode, as
selected by the user.  In simulation mode, FACET will integrate the aircraft
equations of motion to generate trajectories, using initial conditions obtained
from recorded data.  In playback mode, FACET will simply retrieve track data
from a recorded (e.g., ETMS) file at specified intervals, using interpolation if
necessary.

Both of the above modes can be operated in a synchronous or
asynchronous manner.  Synchronous operation is appropriate if the user wishes
to maintain a fixed correlation (in fast, real or slow time) between trajectory
update display and clock time.  During synchronous operation, there is a linear
proportional relationship between trajectory time stamps and clock time (the
constant of proportionality is called the time-scale factor), and the display is
updated at regular time intervals.  This is the default operational state for both
simulation and playback modes.  Asynchronous operation is appropriate if the
user wishes to move through a trajectory as quickly as possible.  During
asynchronous operation, there is a nonlinear monotonic relationship between
trajectory time stamps and clock time, and the display is updated at irregular
time intervals.

Detailed explanations of these modes and operational states are given
below.
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Nomenclature

D = Display update time interval (sec)

F = Time-scale factor (fast-time if greater than 1.0;  slow-time if less than
1.0)

 Think of F as a fast-forward / slow-motion control knob for
synchronous operations

I = Integration time step (sec)

T = Trajectory update time interval (sec)

Defaults:  D = 10 sec;  F = 1.0;  I = 5 sec;  T = 10 sec  (examples – actual
values TBD)

Simulation Mode

Synchronous operation:  User specifies D, F and I.  In this mode, FACET
takes n  =  F*(D / I) successive integration steps, waits until D seconds have
elapsed, and then displays the results.  If n is not an integer, then round up to the
next integer (N), and use an adjusted integration time step I' = (F*D / N).

Note that this approach will fail if the clock time taken by FACET to
execute n (or N) successive integration steps exceeds D seconds.  In this case,
FACET will display a warning dialog box saying that it can’t keep up and will
ask the user to either decrease the value of F and/or increase the value of I
(changing D won’t help !).

Example:  Let D = 10 sec,  I = 2 sec,  F = 3.  If the current time is t, FACET
will integrate forward using n = 15 steps to calculate the aircraft states as they
would be at (t + 30) sec.  Assuming that these calculations are performed in, say,
6 seconds, FACET will wait for 4 more seconds and update the display at (t + 10)
sec. Note that if we select I = 4 sec, then n = 7.5 is not an integer.  Therefore, we
r o u n d  7 . 5  u p  t o  t h e  n e x t  i n t e g e r  t o  o b t a i n
N = 8.  The adjusted integration time step is I' = 3.75 sec.

Asynchronous operation:  User specifies T and I.  In this mode, FACET takes
n  =  (T / I) successive integration steps, and then immediately displays the
results as soon as they are available.  If n is not an integer, then round up to the
next integer (N), and use an adjusted integration time step I' = (T / N).
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Example:  Let T = 30 sec,  I = 2 sec.  If the current time is t, FACET will
integrate forward using n = 15 steps to calculate the aircraft states as they would
be at (t + 30) sec.  Assuming that these calculations are performed in, say, 6
seconds, FACET will update the display at (t + 6) sec, and continue simulation.
Note that if we select I = 4 sec, then n = 7.5 is not an integer.  Therefore, we round
7.5 up to the next integer to obtain N = 8.  The adjusted integration time step is I'
= 3.75 sec.

Playback Mode

Synchronous operation:  User specifies D and F.  In this mode, FACET
retrieves track data (from the recording) for incremental time (F*D), waits until D
seconds have elapsed, and then displays the results.  Interpolation may be
necessary to retrieve track data at desired time.

Note that this approach will fail if the clock time taken by FACET to
retrieve (and interpolate if necessary) the track data exceeds D seconds.  In this
case, FACET will display a warning dialog box saying that it can’t keep up and
will ask the user to increase the value of D (decreasing F may not help !).

Example:  Let D = 10 sec,  F = 25.  If the current time is t, FACET will
retrieve track data for time (t + 250 sec).  Assuming that these calculations are
performed in, say, 3 seconds, FACET will wait for 7 more seconds and update
the display at (t + 10) sec.

Asynchronous operation:  User specifies T.  In this mode, FACET retrieves
track data (from the recording) for incremental time T, and then immediately
displays the results as soon as they are available.  Interpolation may be necessary
to retrieve track data at desired time.

 Example:  Let T = 250 sec.  If the current time is t, FACET will retrieve
track data for time (t + 250 sec).  Assuming that these calculations are performed
in, say, 3 seconds, FACET will update the display at (t + 3) sec and continue
playback.


